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------------------------------------------------
Programs for All 
Your Office Needs 
1 

Congratulations! You are the owner of one of the most advanced personal com­
puters on the market today. With the right software, you will be able to manage 
and improve every aspect of your business, including financial planning, pro­
motion, correspondence, order entry, and order fulfillment. 

The Macintosh has impressive technical specifications. It has an ultrafast 
MC68000 microchip, for example, whose 32-bit architecture allows the Macin­
tosh to address up to 5 Megabytes of add-on memory. But these technical specifi­
cations mean nothing without the software- the sets of programmed instruc­
tions that tell the computer what to do. 

SOFTWARE IS THE KEY 

The purpose of this book is to guide you to the software you need for your 
business applications and to show you how to put the software to work. This 
book is a practical guide to computerizing your business. It can be read and 
applied in every small business and every home office by accountants, attor­
neys, engineers, contractors, consultants, mail order, manufacturers represen­
tatives, publishers, and physicians. And it will prove invaluable to the manager 
and executive who has budgetary responsibility for running his or her own 
"small business" within a corporation. You learn step by step how to computer-
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ize your most important business operations, and you learn how to maximize 
your benefits with a minimum expenditure of your time and dollars. 

You receive practical, worked-through examples of such popular Macin­
tosh software as Multiplan, Chart, MacWrite, Filevision, MegaMerge, and 
ThinkTank. And you get a guide to dozens of other business applications. 

WHAT DO YOU NEED TO KNOW? 

Knowing computer jargon won't help you to computerize. Instead, you must 
thoroughly understand your business. You need to know your strengths and 
weaknesses. And you need to know what the computer can do for you now, as 
well as three years from now. 

Computer benefits are what this book is all about. Managing Your Office 
With Macintosh will help you in three ways. First, by introducing you to the 
computer's potential with chapters on spreadsheets, charts and graphs, word 
processing, data management, mass mailings, and inventory control. Second, 
with hands-on tutorials. that take you step by step through major business 
applications. Third, you'll use the detailed guides to software and hardware 
selection to increase your capabilities. 

Success in computerizing your business, as in any other business venture, is 
never guaranteed. But you can help cut down the odds by determining which 
jobs a computer can do for you more effectively than you now do for yourself. 

ESTABLISHING YOUR APPLICATIONS 

Almost every business can benefit by using a spreadsheet, a word processor, and 
a data manager. In Chapter 2, you learn how to use Multiplan, an electronic 
spreadsheet, for sales analysis, checkbook reconciliation, chemical calcula­
tions, financial planning, manpower assignments, and preparing a graph. You'll 
discover that there are hundreds of other applications for an electronic spread­
sheet too. 

Graphs and charts are among the most effective ways to get your point 
across. They're particularly valuable when you need to make multiple compari­
sons. In Chapter 3, you learn how and when to make column charts, pie charts, 
bar charts, line graphs, area charts, and scatter plots. You learn how to transfer 
information directly from a spreadsheet to a graph. And you learn how to 
customize each type of graph to. meet your exact reporting needs. 

2 

In Chapter 4 you learn to use MacWrite to prepare letters, reports, and 
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IF Bugstopper's Notebook: 
If All Else Fails 

Computers can be confusing. Throughout this book, you'll find 
these special sections set off from the rest of the text devoted to 
helping you recover from possible errors-human or otherwise. 
We'll show you how to backup and recover your work and how 
to make corrections simply but effectively. So read on, experi­
ment, and enjoy computerizing your office. 

justifications. You learn how to eliminate typists and how to reassign much of 
the text-editing and report-producing work to others. You also learn how to 
combine text, charts, and tables in a single report. In the second part of the 
chapter, you learn how to prepare longer documents and reports with the aid of 
a thought-organizer program called ThinkTank. 

Computerized data management is the topic of Chapter 5. You learn how to 
record and maintain client and prospect information, maintenance schedules, 
experimental observations, and product specifications, how to select prime 
prospects, and how to prepare and print reports and mailing labels. 

In Chapter 6, you apply what you've learned to the preparation of a mass 
mailing. MegaMerge lets you combine the work you've done with your word 
processing and your data-management software to produce personalized form 
letters and mailing labels. 

Inventory control is the topic of Chapter 7. To help increase your turnover 
while reducing the size of your inventory, you learn to use the data-manage­
ment software in Chapter 5 to track the location as well as the quantity of each 
item you have in stock. ~ 

In Chapter 8, you learn a variety of other business applications for the 
Macintosh, including accounting, project and appointment scheduling, com­
munications, and developing your own programs. Capsule reviews of some of 
the more popular business software for the Macintosh are included in Appendix 
I. Appendix II contains a guide to hardware additions that can increase your 
productivity, including extra memory, a telephone modem, and a hard disk. 
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You'll get triple your value from this book. Once, as an introduction to the 
benefits a Macintosh can provide. Once, when you sit down to plan how to 
computerize your business. And once again when it comes time to install and 
take advantage of your Macintosh software. You can have confidence in your 
efforts at computerization from the very start. 

Read the case histories and work through the tutorials, and you'll compu­
terize your office efficiently and successfully . 

. ' 

4 
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------------------------------------------------
A Spreadsheet Has 
1001 Uses 
2 

Electronic spreadsheets are the most popular computer programs on the market 
today. Why are they so popular? "Immediacy, ease of use, and cost," says Clark 
D. Hurlbert, treasurer of the Durametallic Corporation in Kalamazoo, Michigan. 
"But mostly because with an electronic spreadsheet, I need no help from anyone 
else." 

An electronic spreadsheet turns your video display into a gigantic work­
sheet that is already divided into rows and columns. You can type in numbers, 
row and column headings, or formulas, or you can simply tell the program to 
duplicate previous entries. The spreadsheet program does the adding and sub­
tracting for you, along with multiplication, division, partial sums, minimums, 
maximums, and square roots. If you change a number, it will update all the 
entries that depend on that number automatically and instantly. With a single 
instruction, you can alter the format of the display to suit your convenience. You 
can insert or delete rows and columns, alter the column width, or change the 
number of decimal places. And there's never a visible erasure! You can save the 
results for future updates and create a printed copy to show your banker, poten­
tial investors, and the IRS. 

There are literally thousands of applications for a spreadsheet in your of­
fice, including budgets, cash-flow forecasting and analysis, checkbook register, 
chemical calculations, contractor bid calculations, engineering calculations, 
financial planning, inventories, lease-versus-buy analysis, ledgers, loan amorti-
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zation, manpower assignments, market analysis, materials and labor require­
ments planning, performance analysis, pricing strategies, profit and loss state­
ments, rate-of-return calculations, sales forecasts, statistics, surveys, tax 
records, and tax returns. 

WHO USES ELECTRONIC SPREADSHEETS? 

It took Jim Gaston, owner of Gaston's White River Resort in the Ozark Moun­
tains near Lakeview, Arkansas, almost 30 hours working until 4 o'clock in the 
morning to learn to use an electronic spreadsheet. But since those first long 
nights alone, Gaston has developed almost 30 worksheets for different aspects of 
his business -daily sales reports, year-to-date and month-to-date sales compar­
isons in 23 different categories, and monthly sales tax and alcohol tax reports. 
Gaston says, "I would have to hire three more people to do all the things I can do 
with my spreadsheet. And I've got far better control over my investments." 

Steven Stadler of Genrad, Inc. in Concord, Massachusetts, uses a spread­
sheet and his desk-top computer to make projections about new product lines. 
With the spreadsheet's aid, he can quickly explore a variety of what-ifs. What if 
the price ofraw materials goes up 15 percent in a year or two? What will be the 
effect on profits? By changing a single number on the worksheet, he can assess 
the ramifications for three years of sales. 

A spreadsheet is among the easiest programs to learn how to use. You can be 
doing productive work within half an hour (or you can stay up all night with the 
manual in hand if you want to master every last subtlety). The table shown in 
Figure 2-1 took exactly 60 seconds to prepare; to produce a similar table, all you 
need to know is how to type. To convert this table to a full-fledged sales analysis 

FIG. 2-1 

6 

BOOK SALES FOR FIRST SIX MONTHS 

Jan 
Feb 
Mar 
Apr 
May 
June 

Total 

350 
500 
900 

1200 
400 
250 

3600 
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.S File 

will take you only about 45 minutes with the aid of the instructions given in this 
chapter. 

Also included in this chapter are step-by-step instructions for creating 
spreadsheets for (1) tracking taxable expenses, (2) assigning tasks to personnel, 
(3) computing interest on a bank deposit, and (4) creating a graph to show your 
banker. 

There 's a big difference between just using a spreadsheet and using it 
effectively. In the concluding section of this chapter, you receive tips on apply­
ing advanced features of a spreadsheet and learn six simple rules for increasing 
the spreadsheet's value to your business. 

Lliew Special 
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I . . 
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0 0 
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FIG. 2-3 
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BUILDING A TABLE 

The spreadsheet is so well adapted to organizing facts and figures into tables that 
I use it in preference to MacWrite for this purpose. With a spreadsheet you can 
easily insert, delete, or move a column any time you change your mind. You can 
increase or decrease the column width and add decimal points and dollar signs 
-all without a single erasure. And you can compute row and column sums 
automatically. 

Getting started is easy. Insert the Multiplan disk in the drive and turn on the 
Macintosh. (If you already have a disk in the Macintosh, eject it by double-click­
ing the mouse button as soon as you turn on the computer. If you own a second 
disk drive, put your data disk in it.) The Multiplan master document menu 
(Figure 2-2) will appear on the screen. Use the mouse to point the cursor at the 

8 
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Multiplan folder on the far left of the menu and double-click. You hear the 
internal disk drive whirr and in a moment you see the Multiplan spreadsheet 
(Figure 2-3). 

Note that the 6 columns and 15 rows that appear on your screen are only a 
small fraction of the potential spreadsheet, which may be as large as 63 columns 
and 250 rows. Don't believe me? Move the cursor to the right or bottom border of 
the screen to scroll to the other hidden areas of the spreadsheet. Point to the 
arrow and click to move a column or row at a time. Point to the boxes (next to the 
arrows in the upper-right and lower-left corners initially) and drag them down 
or across to scroll across several rows or columns at one time (see Figure 2-4). 

Now we're going to use the keyboard to enter a column of figures. 
Move the cursor to row 1 of column 1 and click. (If you have completed the 

previous exercise, you will need to use the arrows and boxes in the borders to 
scroll back to this section of the spreadsheet first.) 

FIG. 2-4 
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FIG. 2-5 
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10 
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14 
15 

Untitled 

1 2 3 4 5 6 
350 : : ................................................................................................................. . . . . . 

Enter the figures as shown in Figure 2-5. Type 350 and press Return. (The 
cursor will advance to the second row of column 1.) 

Type 500 and press Return. 
Finish entering the rest of the numbers. Each time you press Return, the 

active cell (colored black) moves down one row in the column. 
I didn't just choose the numbers 350 and 500 at random. Several years ago, I 

decided to self-publish my first book, Choosing a Word Processor. (You notice 
that I've not made the mistake of trying to publish and distribute this book 
myself.) We started distributing the word processing book in January and along 
about July I decided it was time to start keeping track of sales. What you see in 
the first column are the sales figures for these six months. 

This table leaves something to be desired. There's no title and we've left out 
the names of the months. But we don't need to erase or start all over. This is an 

10 
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electronic spreadsheet and it will take us only a few seconds to rearrange the 
display. 

First, let's insert two rows at the top of the table so we can put in a title. To 
insert an empty row takes three steps: 

1. Press the shift key (at the right or left end of the second row on the 
keyboard) and hold it down. 

2. Point with the cursor to the number "1" which labels row 1 (it's at the top 
left of the spreadsheet). 

3. Click. (Now you can release the shift key.) 

Repeat this procedure twice, and the spreadsheet will look like Figure 2-6. 
You may insert an empty row or column anywhere in a spreadsheet even 

FIG. 2-6 
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FIG. 

.- Made a Mistake? 
It's easy to correct an accidental typing error. Use the cursor, if 
necessary, to return to the cell where you made the mistake. 
Use the backspace key to erase the characters you typed incor­
rectly, then type them again. 

If you need to erase several cells at one time, mark them 
with the cursor, then select the Clear option from the Edit menu. 

2-7 
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.- Printing a Hard Copy of 
Your Results 

To produce a hard copy of Figure 2-1 just as it appears in this 
book takes three steps. First, turn on the printer. Next, drag the 
cursor across the display to mark off the region covered by the 
table from row 1, column 1, to row 11, column 4. Last, pull 
down the Edit menu as shown in Figure 2-8, select the Print 
option, and stand back. If you'd like to reproduce everything 
that's on the display screen-borders, menus, and all-depress 
the Caps Lock key on the left side of the keyboard and hold 
down the shift key, the X key, and the numeral 4 simultaneously. 

after it is completely filled in. To insert a column (row), hold down the shift key, 
point with your cursor to the column (row) number where you want the insert, 
and click. To test your understanding, insert an empty column at the left of the 
table for the names of the months. (Hint: After depressing the shift key, point 
with the cursor to the number "1," which labels column 1; it's in the row 
immediately above the spreadsheet.) 

Move the cursor to the third row of the column you've just inserted (R3C1), 
click and type Jan [return], Feb [return], Mar [return], Apr [return], May [re­
turn], June [return] until you've filled out the column. 

Now the table almost looks like Figure 2-1. 
We're not finished, however. The original intent of this table was to track 

the sales of my book. We can't really tell anything from the table until we sum 
the sales figures. Move the cursor to the foot of column 2 in row 10, column 2, 
where you will enter the summation formula 

Type: = 

(This tells the computer that you are about to enter a function or formula.) 

Type: SUM( 
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(This tells the computer that you want to compute a sum.) 
Move your cursor to the first figure in the column (350), click and continue 

to hold down the click button as you drag the cursor down the column offigures 
that you want to sum. You have just defined the range over which you will sum. 
Now the screen looks like Figure 2-7 . 

Type: and press Return 

The sum 3600 appears at the foot of the column. Add the titles, "Book Sales 
for First Six Months" and "Total," and you have Figure 2-1. 

14 

FIG. 2-8 
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GETTING HELP 

Multiplan has many functions like SUM that can simplify your calculations. 
You can access this list or get help with any ofMultiplan's other features when­
ever you use the program. Here is how: 

Point the cursor to the apple (at the far left of the menu line at the top of the 
screen) and pull down the apple menu. Point the cursor to the first item on the 
menu, "About Multiplan," and click to see the Multiplan help menu (Figure 
2-9). Scroll through this menu by dragging the cursor down its border until you 
find the item about which you want additional information. Point to the item 
and click. Then move the cursor down to the "Help" square and click again. 
Figure 2-10 is the display you receive when you ask Multiplan for help with its 
statistical functions. (To return to the spreadsheet, move the cursor to the "Can­
cel" square and click.) 

MAINTAINING AN ELECTRONIC CHECKBOOK 

How to Get a Free Desktop Computer is the title of an excellent book by Vernon K. 
Jacobs CPA, FPA. It's $9.95 from Research Press, 4500 West 72nd Terrace, 
Prairie Village KS 66208. However, I'll give you Jacobs's secret for free: Make 
your computer tax-deductible. 

The best way to make your computer tax-deductible is by using it for 
business purposes. In this section, you learn how to use your Macintosh and the 
Multiplan spreadsheet to maintain an electronic register of checks in which you 
record your withdrawals and deposits. 

For example, my own checkbook register is shown in its raw form (Figure 
2-11) as it appears in part on the Macintosh display. I use this register to maintain 
a running balance, to reconcile my bank statements at the end of the month (I 
keep a separate register for each account), and to help prepare my tax return. 

Figure 2-11 shows our new electronic checkbook as of the 15th of the 
month. To get to this point, you have to make extensive use of Multiplan's 
Format menu. We have modified the column widths and, in the case of columns 
4 to 6, converted to dollar format in which all negative amounts are enclosed in 
parentheses. 

Turn on the computer and load the Multiplan spreadsheet. If you are con­
tinuing from the last example, you will have to clear the screen before you can 
go any further. One quick way to clear the screen is to use the "New" option 
from the File menu. 

When we first load a new spreadsheet into Multiplan, all columns are the 
same width, 10 digits across, and all numbers are automatically given the Gen-
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FIG. 2-9 

FIG. 2-10 
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Minimum ualue in list 

Net present ualue of list at rate 

( NeHt ) ( Preuious) ( Cancel J 
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eral format. To change the format column by column, point to the column whose 
format you wish to change, say column 1, and pull down the Format menu. 

Multiplan's pull-down Format menu (Figure 2-12) has 13 options, including 
dollar, percent, decimal, and no decimal. To convert a selected number or 
column to a dollar format, point with the cursor to the word "Dollar" and click. 
To alter the width of a column, select "Column Width." 

Let's begin by shrinking the width of the first column, the one that will 
contain the check number. Move the cursor to the "1" at the top of the first 
column and click; the entire column turns black to show that you have selected 

LIBRARY 
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FIG. 2-12 
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Decimal 
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Bor Graph 

Number Of Decimals ... 

Rlign Left 
Rlign Center 
Rlign Right 

Commas 
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11 
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13 
1't 
15 

. ...... :· ·· ···············: .. ··----
. . . . .. . .......... ................... ............ . 

it. Pull down the Format menu and select Column Width. Enter a 5 when you are 
asked to specify a width (see Figure 2-13) . 

Repeat this procedure for columns 2 and 3, using 6 for the width of column 2 

(the date) and 20 for column 3 (the account description). You could format 
columns 4, 5, and 6 individually, but there is a much faster way to change the 
format of several adjacent columns. Simply drag the cursor across the column 
numbers before pulling down the Format menu, as shown in Figure 2-12 . 

To format several columns that are not adjacent, use the following proce­
dure: Point to the number at the top of the first column and click. The entire 

-JI 
>Ill 
>ll~i 

:::::::::: !i!i!i 
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FIG. 2-13 
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D Set Rll Columns to Standard Width 
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column will turn black. Now, hold down the command key-the key marked 3€ 
on the left side of the bottom row- and point/ click each of the remaining 
columns. This is the technique to use when creating an alternating dollar/ de­
scription format for a ledger or accounting journal. 

COMPUTING A RUNNING BALANCE 

When you have altered the column widths and entered the column headings to 
suit your convenience, you are ready to enter the formula for the running 
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balance: 

Balance [to date)= Opening Balance 
+Deposits [to date) - Checks [to date) 

To anchor the sum of the deposits in the first active cell, row 2, column 6, type: 

=SUM[R1C5: 

Then move the cursor to row 2, column 5, and click. Now the display reads: 

=SUM(R1 C5:RC[-1] 

I FIG. 2-141 
s File Edit Select Format Options Calculate 

Checkbook. final 
1 2 3 4 5 6 

1 NUM :DATE :ACCOUNT :CHECK :DEPOSIT :BALANCE I 

2 :1:~9~::~~(~:q:(::~tj~~~:r:~~:~~~~~~(:::::::~::::::::::::::::i?~~;:?:~J•&lo:: 1i1m 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
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13 
14 

R2C6 

NUM 
1000 

To anchor the sum of the checks, type: 

)- SUM[R1 C4: 

Then move the cursor to row 2, column 4, and click. Now the display reads: 

=SUM[R1 C5: RC[-1]) - SUM[R1 C4: RC[-2] 

Type a closing parenthesis and press Return. The display looks like Figure 2-14. 
Finally, copy the running-balance formula down the column. Click the 

cursor and drag it down the balance column as shown in Figure 2-15. Pull down 
the Edit menu and select "Fill Down" to copy the formula to each cell of the 
balance column. 

FIG. 2-15 
Select Format Options Calculate 
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Pns1 <~ mid Unk .. , 
UnHnk .. , 

P1~s1 <~ N1mw '" 
Paste Function ... 
Rbsoh11 <~ R<~fernn< •~ :•:l 
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$743.21 ........... .......... .... ... .. .... 

6 
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Note that it is the formula and not the amount in row 2, column 6, that is 
copied so that at any point in the column, the balance that is calculated and 
displayed is the sum of all deposits less the sum of all withdrawals to that point. 

SORTING A COLUMN 

In our office, we throw our receipts into a folder as we go, and only at the end of 
the month do we actually enter them into the ledger. This nonsystem is reflected 
in the order of the checks, check 1008 is followed by check 1004, and a deposit 
for the 12th of January is followed by a check made out on the 5th. This is a 

FIG. 2-16 
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convenient way to enter the information, but it's not very effective when it 
comes to keeping track of your current balance or reconciling your checkbook 
with your bank statement. Fortunately, Multiplan allows you to sort the items 
by date (or any other criteria, such as account or check number). 

In Figures 2-16 and 2-17 , I've sorted the check register, first by date and last 
by account type. To sort the register, first use the cursor to highlight the items 
you wish to sort and the variable you wish to sort by, the date in this case. Point 
to the first entry in the date column (row 3), click, and pull the cursor down to 
the last entry (we finished in row 14). The entries you selected will be marked in 
black. Pull down the Edit menu and select "Sort," the last item on the menu. 
You'll be asked whether you want to sort in ascending or descending order. 
Choose ascending order and press Return (or click the "OK" button). The result, 
the newly ordered ledger, is shown in Figure 2-16. (As an exercise, sort by 
account type to obtain Figure 2-17.) 
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The rearrangement is not entirely successful. One entry, 1007, a check 
made out to the postmaster for $60, lacks a date and as a result is out of sequence. 
However, you can correct the error quickly-if you catch it in time. Go back to 
your records before you file them away or discard them and find the missing 
date. (You'll need a consistent set of records when you go to your banker for a 
loan or respond to a summons from the IRS.) 

MANPOWER ASSIGNMENTS 

It always seems to be feast or famine in my business. One week, I'm out trying to 
scrounge up work, the next I'm interviewing temporary help and trying to 
manage five projects at one time. I've learned that the key to a profitable opera­
tion lies in keeping all your workers fully employed. This means you must plan 
your assignments long before you begin a project. In this example, you learn to 
use Multiplan and your Macintosh to make manpower assignments. You also 
learn how to reduce the time needed to prepare a spreadsheet by replicating a 
spreadsheet formula rather than retyping it. 

As always, the initial entries on the spreadsheet are identical with those 
you would make if you were working with pencil and paper, except that Multi­
plan has already ruled off the spreadsheet for you into rows and columns. 

Start several rows and columns from the top-left corner of the spreadsheet 
to leave plenty of room to add labels and titles later. In the cells of the first 
working row (row 4 in this case), enter the names of the members of the work 
group. In my case, this included Kathy, my wife, Phil (that's me), Bud, our trusty 
editor and general factotum, Donna, a specialist we'd brought in from the out­
side specifically for Project X, and Denise, our part-time typist (see Figure 2-18). 
To make your work fit on the Macintosh display screen, reformat columns 3 
through 10 to a width of six.) 

To advance horizontally across the row after each name you enter, press the 
Tab key on the upper left of the keyboard. 

Put the names of your projects in the cells of the first working column 
(column 2) and insert the titles shown in Figure 2-18. (Remember to unclick row 
4 before you start.) In my case, I have a newsletter, a book in progress ("CP /M 
book"), a set of reports we were shipping in response to a recent mail-order 
campaign, and "Project X." (This time, press Return after each entry in order to 
advance down the column automatically.) 

Two additional columns, 8 and 9, are needed at the right side of the table. In 
column 8, type in the man-hours that have been budgeted for each project. (In 
this example, our newsletter had 25 man-hours, the book had 60, and so forth.) 
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In column 9, we will program Multiplan to sum the man-hours we've already 
assigned. 

Use the mouse to move to the newsletter entry under MHr Assigned (shown 
here in row 5, column 9) and click. 

Type: =SUM( 

Use the mouse to point out the range over which you are summing­
columns 3 through 7 -by holding down the click button continuously. Let the 
computer fill in the formula SUM(RC[-6]: RC[-2], as in Figure 2-19. 

FIG. 2-19 
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Type : and press Return 

Since you haven't entered any numbers yet, a sum of zero will be displayed. 
Now you want to replicate this formula in the remaining three cells of this 

column. You could repeat these steps three times, but there is a much faster 
way: 

Return the cursor to where you just entered the SUM formula (R5C9), then 
press the button and hold it down while you drag the cursor through the cells 
where you wish to replicate the formula. Now pull down the Edit menu as in 
Figure 2-20, select "Fill Down," and click. Immediately, the formula is repli­
cated in each of the remaining cells in the column. 
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Similarly, add two additional rows at the bottom of the table in which to 
keep track of the work hours on a person-by-person basis (see Figure 2-21). In the 
first of these two new rows, record the number of budgeted (available) work 
hours. In this example, Kathy has 40 hours available, Phil, a tireless worker (and 
the owner of the company) has 50, Bud has 30, and so forth . 

Next, you want to sum all the hours assigned to each individual, be­
ginning with Kathy. Use the cursor to enter the summation formula 
=SUM(R[-6]C: R[-3]C) inR11C3, the first working column of the second extra 
row. Replicate this formula along the row, but this time use the "Fill Right" 
command from the Edit menu. 

Move the cursor down one more row to row 12, column 3, and click. Then 
use the cursor to enter the formula for the difference between the budgeted and 
assigned work hours =R[-2]C-R[-l]C. (If the difference is negative, plan on 
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~ Saving ta Disk 
It's always a good idea to save your work on disk at regular 
intervals. Use a separate disk for this purpose. If you have a two­
drive system, then use a data disk you've put in the second 
drive. If you have only one disk drive, then save to the program 
disk temporarily and copy to the data disk when your work is 
completed. Never, never use the program disk for long-term 
storage. (If your data are essential to your business, you may 
want to make a second backup copy at the end of each day or 
each week and store it at a remote location.) 

Use lengthy descriptive names for each of your files. Include 
the date of the update if possible. It's always a good idea to keep 
a copy of the last version of a file in addition to the current 
version-just in case you have second thoughts. 

paying overtime or dropping from exhaustion.) Replicate this formula along the 
twelfth row using the "Fill Right" command. 

Similarly, enter the differences between the assigned and budgeted hours 
in column 10, the third extra column. A negative result warns you that shortly 
you'll be falling behind. Again, to enter the difference formula, move to the top 
cell of the column where you want to enter the formulas, R5C10, click, and use 
the cursor to point out the two cells whose difference you are computing. Then 
pull down the Edit menu and "Fill Down" column 10, rows 5 to 8, with this 
formula. 

Stop! Before you go any further. Save the template you've just created on 
disk using the Save As . . . command on the File menu. 

MAKING TENTATIVE ASSIGNMENTS 

Now fill in the preliminary work assignments as Kathy has done in Figure 2-22 
and Figure 2-23. As you do so, the numbers in the last row will gradually go from 
positive to negative. When you get a negative result, stop and adjust the figures 
until all differences are either positive or zero. (If you don't, somebody has just 
"volunteered" to work overtime.) At this point, you may want to add additional 
personnel or projects or just lie down for a while until you feel better. But first, 
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make a copy on disk of this initial assignment. Use a different file name than the 
one you assigned to the template itself. 

It could be argued that the resulting work (or equipment) assignment is not 
optimal, that you could do ~uch better if you used a critical path method or a 
PERT chart. But quite the opposite is true. You can't enter your gut instincts and 
prejudices into a formal sch1eduling program-there's no room on the form. The 
spreadsheet method is interactive; you can concentrate on assembling teams 
that work well together, letting the spreadsheet perform the arithmetic to satisfy 
the row and column sum requirements. 

For example, in passing from the preliminary set of assignments in Figure 
2-22 to the final set in Figure 2-24, I might have done the obvious and let poor 
overworked Phil (10 extra hours already show in his column in Figure 2-23) 
spend five hours less on the newsletter, which shows a budgetary excess of five 
hours in the same figure. This would ignore Phil's pivotal role on the newsletter 
-something that's hard to write down in any sort of a computer program-and 
Kathy's skill as a supervisor, which is so essential to getting the CP /M book out 
on schedule. Figure 2-24 represents the final optimal assignment of talent to 
tasks. Now see what you can do with Multiplan for your business. 

COMPUTING INTEREST ON A BANK DEPOSIT 

A spreadsheet is extremely handy whenever you need to make a quick calcula­
tion. In this example, we will compute the interest on a bank deposit that is 
compounded monthly for a range of annual rates. You will also learn more about 
Multiplan, including how to use both absolute and relative cell references. 

First, enter the titles and column headings as shown in Figure 2-25. Then 
enter the months after deposit. You could simply type 0, 1, 2, 3, ... down the 
first column, but there is a much faster way. In row 4, column 1, type: 

= Row()-4 [return] 

The = tells Multiplan that you will enter a function rather than a label. The 
function Row() yields the number of the row in which it appears, a 4 in this case, 
so that, for example, Row() - 4 is 0. 

Does this seem like a complicated way to type a zero? If you had to type a 
similar expression for each number in the column, it could take you all morning. 
Fortunately, there is a faster way: You will replicate this expression in every cell 
of the column. 

Return the cursor to where you just entered the formula (R4C1), then click 
and hold the button down while you drag the cursor down the column through 
the cells in which you want the formula replicated. Stop in row 16, pull down 
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the Edit menu and select "Fill Down." The formula is immediately replicated in 
each of the designated cells in the column. 

Next, let's enter the range of interest rates. Recently, the banks in my area 
were offering rates between 11 percent and 11.5 percent per an um compounded 
monthly. Mark columns 2, 3, and 4 of the third row with the cursor and enter 
these percentages in decimal form: .1100 [tab], .1125 [tab], and .115. Be sure to 
press the Tab key between each entry and not the Return key. To convert these 
three numbers to percentages, just click Percentage in the Format menu. Simi­
larly, mark off the area from R4C2 to R16C4 with the cursor and format these 
cells as Dollar. Enter the amount of the deposit, 100 (dollars), in row 4 of column 
2 and Fill Right across columns 3 and 4. The result is Figure 2-25. 

Now you can begin to compute the interest earned each month. This inter­
est is the product of the amount that is already on deposit and the monthly 
interest rate (the annual interest rate divided by twelve), or in Multiplan nota­
tion: 

=R[-1]C*(1 +R3C2/12) 

Move the cursor to row 5, column 2. 

Type: = 

(This tells Multiplan you will enter a formula rather than a label.) 
Move the cursor to row 4, column 2 (where the amount you are depositing is 

located), and click. The display reads: 

=R[-1]C 

R[-1 ]C is called a relative reference because it describes the amount in 
terms of the location relative to the cell in which the formula appears, one row 
previous and in the same column. In the preceding example of a work assign­
ment, such relative references were used repeatedly. And a relative reference is 
correct in this case, since you will always express the current month's balance 
as a percentage of the preceding month's balance . 

Type: • 

(This means times.) 

Type: (1 + 
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...- Error Messages 
Occasionally, after you enter a number or formula, Multiplan 
displays a series of pound signs ###### or some other error 
message instead of the answer you expect. There are two 
explanations. First, the number is too large for the column. For 
example, the number 12345.678 won't fit in a column that is 
only five digits wide. Second, the formula you provided is in 
error. Read over the formula to be sure that you entered it 
correctly. If you can't spot the error immediately, break up the 
formula into smaller, easily checked sections and try to repro­
duce the computations by hand. For the meaning of other error 
messages, check the Multiplan Reference Guide. 

Now move the cursor to where the interest rate is located (in row 3 of the same 
column) and click. The formula bar at the top of the screen reads: 

=R[-1 ]C * (1 + R[-2]C 

R[- 2]C is also a relative cell reference. But if you try to replicate this 
formula down the column, its relative nature could trip you up. All of your 
calculations must be based on the same (absolute, not relative) interest rate. To 
be on the safe side, let's convert this reference immediately to the absolute 
reference R3C2. 

Pull down the Edit menu and select" Absolute Reference." The formula bar 
at the top of the screen changes to read: 

=R[-1]C*(1 +R3C2 

(If you try to select Absolute Reference a second time for this same entry, 
you'll find that the Edit menu now reads "Relative Reference." As an exercise, 
convert the formula back and forth several times.) 

The interest rate in R3C2 is an annual one. To convert to a monthly rate, 

Type: /12 

Last, type a closing parenthesis ). 
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When you press Return, the computer displays the total amount on deposit 
after the interest is credited at the end of the first month, which is $100.92. Is this 
too much work just to do one calculation? You bet. But the result is accurate. (In 
fact, the amount stored in R5C2 is really 100.91667, something you can verify by 
switching to the General format from the Format menu.) And it will take you 
only two more steps to fill in the balance of the column: 

Mark off the area from R5C2 to R16C2 over which you want to replicate the 
formula by dragging your cursor down the column. Fill Down from the Edit 
menu. 

The result is Figure 2-26, and at the foot of the table you see that an 11 
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percent interest rate compounded monthly corresponds to an 11.57 percent 
annual return. 

As an exercise, fill in the balance of the spreadsheet. 

SCIENTIFIC AND ENGINEERING CALCULATIONS 

We've taken advantage of only a few of Multiplan's many built-in functions in 
the examples in the chapter. The exceptions .are SUM(list), which we used for 
summing the contents of rows and columns, and ROW(), which we used to enter 
time intervals. If you want to monitor a stock portfolio, you will probably take 
advantage of AVERAGE, MAX, and MIN. And for scientific and engineering appli­
cations, you can choose from built-in formulas for average, arctangent, absolute, 
exponential, and logarithm and decision-making functions like IF, AND, NOT, 

and OR. (You may also enter and display entries in scientific/ exponential nota­
tion.) 

Do you want to know the angle of incidence at 8:00 A.M. for a solar collector 
tilted at 35 degrees in a house located at latitude 40 degrees on a winter day 
when the angle of declination is 16 degrees? The answer, obviously, is given by 
the well-known Multiplan formula: 

ACOS(SIN((40-35)*Pl[)/180)*SIN(16*Pl[)/180) 
+ COS((40-35)*Pl[)/180)*COS(16*Pl()/180)*COS(BOO*Pl()/180)) 

Not so obvious? Actually, this is a good example of when not to use a 
spreadsheet. Certainly, the formula above comes close to pushing a spreadsheet 
to its limits. It would help if you broke the formula up into parts, gave each part a 
name (using the Name command on Multiplan's Select menu), and performed 
the calculation only as a final step. But in this case, as in most examples where 
the formulas involve several unit conversions, you can solve the problem more 
readily and with greater insight by taking advantage of programs specifically 
designed for engineering and scientific calculations. 

GRAPHING THE RESULTS 

Let's create a bar graph from the initial sales-analysis data to take with us to the 
bank. In other words, take the data of Figure 2-1 so that they look like Figure 
2-2 7. (If you plan to follow along, load the table you built in the first example. Did 
you save this table on disk? Oh well, it will take you only a minute or so to type it 
in again.) 
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FIG. 2-27 
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To begin with, you need to format a column to hold the graph itself. Move 
the cursor to column 3 and select from the Format menu a column width of 40 
and the option "Bar Graph." Later, we will copy the sales figures in column 2 to 
this column. First, you must rescale the figures so they can be graphed within 
the confines of column 3. I've chosen to use twice the column sum as the scaling 
factor for this example. The copying and scaling is done in two stages. First, 
create the initial entry, then Fill Down the column. 

To compute the initial entry in column 3, move the cursor to R3C3. 

Type: = 

Move the cursor to the entry 350 in the adjacent column and click. 

Type: / 
Type: (2* 
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Move the cursor to the column sum in R10C2 and click. At this point the 
screen displays =RC[-1]/(2*R[+7]C[-1]. 

Pull down the Edit menu and select "Absolute Reference." Now the screen 
displays =RC[-1]/R10C2. 

Type: )O/o and press Return. 

A bar representing the January sales expressed as a percentage of the total sales 
appears on the screen. 

Next, copy this formula down the column so that the length of the bar in 
each case is proportional to the sales figures listed in column 2. Return the 
cursor to the first entry in Column 3 and click. Press the button and hold it down 
while drawing it to the end of the column (row 6). Release the button and pull 
down the Edit menu. Select "Fill Down" from the Edit menu. A bar appears in 
each cell in the column so that the spreadsheet looks like Figure 2-27. 

USING A SPREADSHEET EFFECTIVELY 

As your experience with Multiplan grows, you'll find yourself using it for more 
and more complex applications like business plans, portfolio management, bud­
geting, and aged accounts receivable. Just as with any other business endeavor, 
making effective use of a spreadsheet requires careful preparation. Six rules can 
help you increase your effectiveness: 

1. Know your application 
2. Keep the worksheet simple 
3. Design the worksheet to be self-verifying 
4. Backup and protect your work 
5. Maintain a clear audit trail 
6. Document your work 

KNOW YOUR APPLICATION 

Know your application before you start. Get your formula right, and be sure to 
write down the source of all the formulas that you use both on the spreadsheet 
and on separate printed documentation. 

Keep it simple. Use several linked spreadsheets that will be completed 
separately rather than one big all-purpose data-entry form. (Note that Multiplan 
has a link command that provides for the automatic transfer of data from one 
worksheet to another.) Group all the data that are to be entered in one portion of 
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the spreadsheet, either a single column, adjacent columns, or an adjacent block 
of cells. Give the area a name, using Multiplan's name command, and set it off 
with plenty of blank space. It's only paper. (Actually, because the "paper" is 
electronic, it's only blank space.) Take the time to develop meaningful labels 
and column headings-especially if you want to know what the form means six 
months from now. Reduce or eliminate possible ambiguities. 

Don't succumb to the temptation to use abbreviations in order to get more 
on the screen. Use two, three, or even four screens to enter the data if you need 
to. Put a single instruction in the bottom left-hand corner of each screen tc1 guide 
your employees from one to the next. 

Use named variables. It's so much easier to locate and understand the 
meaning of Profit= Income - Expenses than R11C6 = R10C5 - R10C4. 

DESIGN THE FORM TO BE SELF-VERIFYING 

Correcting an error is straightforward if you do it right after you make the error. 
It can be an all-day effort if you put off making the corrections until a later time. 
Make sure that the data are being entered correctly. Format data items for easy 
reading: Use commas, decimal points, and dollar signs and provide checksums. 

One spreadsheet trick is to subtract the checksum from the actual sum of 
the items, then multiply the result by the largest number the spreadsheet will 
hold. If the difference is nonzero, the spreadsheet will flash a warning on the 
screen. 

PROTECT YOUR WORK 

Use Multiplan's "Protect Document" and "Freeze Title" commands (on the 
Options menu) to protect essential elements from destruction, especially those 
that you paid an expert to create, like labels, formulas, and critical constants. 
And backup your work regularly. Keep your master template with labels and 
formulas on one disk and the completed worksheet containing all the figures on 
a second disk. Avoid using the Multiplan program disk for storing data except 
temporarily. 

MAINTAIN A CLEAR AUDIT TRAIL 

Label all printed reports with the name of the folder and the disk on which the 
template used to create it is stored, the name of the individual who created the 
template, the date it was completed, and the names of the individuals who 
entered the data. (The latter does a lot toward creating pride in one's work.) 
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DOCUMENT YOUR WORK 

Documentation is essential. Don't try to be your own expert, data-entry clerk, 
cook, and chief bottle washer. Don't kid yourself into believing that in six 
months everything you've done will be as crystal clear in your mind as it is now. 
Spend as much effort or more on documenting a template if you work alone as 
you would if you had a whole staff to assist you. (This is where Multiplan's Name 
command really comes in handy.) 

Test the template before you turn it over to someone else. Try it out on 
yourself, then try it out on a trial basis with one or two data-entry clerks. 

INCREASE THE VALUE OF YOUR TIME 

A number of hardware enhancements, including additional memory, a second 
disk drive, and a hard disk, can substantially increase your productivity. 

Buy as much extra memory as you can. Although, there are 128,000 bytes 
(characters) of memory in the basic Macintosh, no more than42,000 of these are 
available for use in a spreadsheet. (The Multiplan program and the Macintosh 
operating system occupy the remainder.) 

The actual number of rows and columns available to you will depend upon 
the contents of your spreadsheet. Formulas take up much more memory than 
labels and digits, for example. Increasing your memory to 512 Kilobytes will give 
you almost ten times as much room and will increase the speed of operation, 
particularly with extra-large spreadsheets. 

Unfortunately, extra memory creates its own problems. You may not notice 
the delay when your worksheets are small, but whe_n you are working with 
extra-large worksheets, say 48 columns by 200 rows, you can spend from 5 to 10 
minutes waiting for the worksheet to be transferred to or from a floppy disk. A 
hard disk can cut the delays by a factor of 10 or more. 

For almost any spreadsheet application, a second disk drive is a must. Then 
you can keep your program on one disk and your spreadsheet on another. 
(Trying to use your program disk for data storage is suicidal. All too soon you run 
out of space for new worksheets, sometimes in the very middle of an operation.) 
A second disk drive also makes it more convenient to backup your important 
data files, the best way to avoid the loss of essential information. See Appendix II 
for a list of the many competing hardware options. 
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------------------------------------------------
Charting Your Ideas 
and Results 
3 

Graphs are ideal for expressing both ideas and results. A picture is worth a 
thousand words. Charts and graphs can bridge the gap between your vocabulary 
and those of your clients and your banker. The charts you prepare at your 
Macintosh can be used for presentations, for advertising copy, for creating pro­
cess and flow diagrams, and for architectural and engineering design. You can 
use the computer for generating "quick art" or for bypassing the art department 
altogether. And, with a Macintosh, you can tuck the computer under your arm 
to bring to the presentation. 

DATA ANALYSIS, PRESENTATIONS, AND DESIGN 

Data analysis. A graph is an essential prerequisite to data analysis. Looking 
at a graph, you see trends and deviations in a way that no single set of equations 
or summary statistics could reveal.You view both the individual data points and 
the general trend of all the data points. The graph is a way of exhibiting existing 
relationships and of jogging the mind to uncover new relationships. Chart for 
the Macintosh has an analysis function which automatically computes and 
displays a trend line alongside your data. 

Presentations. Computer-aided graphics offer four significant advantages 
for presentations: (1) ease of preparation, (2) ease of presentation, (3) attention­
getting detail, and (4) ease of updating. 

Good: Managing Your Office with Macintosh (Chilton) 

CHARTING YOUR IDEAS AND RESULTS 41 



The impact of an appropriate graphics presentation cannot be overesti­
mated. Scott M. Miller, a vice-president with the Bank of California and senior 
operations officer with the bank's international banking group, makes frequent 
presentations on the application of new technologies in banking, both to pro­
spective customers and as part of the bank's internal training program. Miller 
says, "Nothing could be more effective than a micro to make such graphic 
presentations." 

Miller has used a microcomputer for the past two years to prepare and 
present his ideas to audiences of one to a hundred. He actually brings his micro 
to the conference room along with an extra-large monitor or a large-screen 
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projection T.V. He also uses his micro to replace an art staff for more traditional 
graphic preparations-printed charts, transparencies, and slides. You too can 
do without an art staff's services (and the delays and false starts this normally 
entails) because programs like Chart provide you with control over every aspect 
of each graph, including the height, style, and positioning of titles, labels, and 
legends. 

Design. Although you may not be able to draw a straight line and your 
handwriting is less than perfect, you can use the Macintosh and graphics soft­
ware like Filevision and MacPaint to produce absolutely flawless designs and 
sketches. 

Paste and Link 
Unlink ,,, 

Show Clipboard 
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The Macintosh gives the designer tremendous flexibility. You can experi­
ment quickly and easily with a variety of alternatives, all without a single 
erasure. You save time because you can combine portions of several existing 
designs to create a new drawing. And altering the aspect, the proportions, or the 
size of a given design is accomplished in a matter of minutes, not hours. 

USING THE CHART PROGRAM 

There are essentially two types of graphics software: One for graphs and charts 
and one for designs and drawings. You will learn to prepare graphs and charts in 
this chapter and designs and drawings in Chapter 7. 
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FIG. 3-4 
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Chart, the first program you will learn to use, allows you both to analyze 
data and to present it. With Chart's aid, you will be able to: 

46 

• Select the graphics format that will make your point most effectively 
• Express your message without compromise or abbreviation 
• Highlight specific chart elements through shading, size, and location 
• Present your message in slides, plots, and transparencies 
• Produce professional, high-quality charts 
• Use data generated by other software like Multiplan and MacWrite 
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FIG. 3-7 
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Chart puts a variety of graphs at your disposal-area charts, bar charts, 
column charts, pie charts, line charts, and scatter plots-and a variety of 
graphic elements, including size, grid, and text. 

EXAMPLE 1: A SALES ANALYSIS 

In Chapter 2, we used Multiplan to construct a simple bar chart. The effort was 
complicated by the need to scale and format the data before we could express 
them in graphic form. Chart does all the scaling for you automatically, a major 
timesaver, as you will see in this example. 
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Let's begin where we left off in the last chapter-with the Multiplan pro­
gram loaded into the computer and the data of Figure 2-28 still on the display 
screen. You will transfer these data to the clipboard and then to the Chart 
program. First, set off the first two columns of the spreadsheet by dragging the 
cursor across them from RlCl to R6C2. Then pull down the Edit menu and 
"Copy" the section you set off. Check the Clipboard (also on the Edit menu) to 
see that the six rows and two columns have been transferred to it (see Figure 
3-1). To quit Multiplan and load Chart, do the following: 

Select "Quit" from Multi plan's File menu. To expel the Multiplan disk from 
the disk drive, hold down the shift key and the command key and then the " 1." 

Now insert the Chart disk. Double-click the Chart icon to load the chart pro­
gram. 

I FIG. 3-81 
~· 
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Once Chart is loaded, pull down Chart's Edit menu and select "Paste," as 
shown in Figure 3-2. The data in the Clipboard will be transferred to the New 
Series tablet, as shown in Figure 3-3. 

(For experienced users: If you select the Paste and Link command rather 
than Paste, then each time you update the sales figures in Multi plan, that update 
will be transferred automatically to the charts you create with Chart.) 

Let's provide Chart with a title and labels for the X and Y axis. Pull down the 
Data window and move and click the cursor to select "Text" from the options 
displayed there (see Figure 3-3). A title form will appear on the display. Start 
typing (no need even to move the cursor) to fill in the series name "Book Sales for 
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.- Correcting Mistakes 
Did you make a typing error? You can rectify most typing errors 
simply by backspacing over the error and retyping it correctly. 
Of course, if you've made a great many errors, your best bet 
may be to start over. To avoid delays, make it a practice to save 
your work at regular intervals. Then if you do have to go back, 
you'll have to redo only part of your work rather than all of it. 

Use the File menu to "Save" a file and to "Open" (and 
recall) a backup copy. 
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First Six Months." Press the Tab key when you are through and the cursor will 
advance to the next field on the Text menu. Then you can fill in the labels for the 
X category, "Months," and Yvalue, "Sales (books)," as shown in Figure 3-4. Press 
Return when you are through. 

To generate a bar chart of the sales data, just check "Plot Series" on the 
series window. The result is shown in Figure 3-5. To see all of the graph in the 
foreground of the display as in Figure 3-6, move the cursor to any point on 
the graph and click. 

You don't have to make do with the bar chart you see on the screen before 
you. Chart offers a whole gallery of options-bar charts, column charts, area 
charts, line charts, pie charts, and scatter plots. To see how easy it is to change 
from one type of chart to another, let's convert a bar chart to a pie graph. 
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BUILDING A PIE CHART 

Pull down the Gallery menu and select "Pie Chart." You see a new range of 
options (Figure 3-7). The third option, the pie chart with one slice detached, 
looks interesting. Select this type by pointing to it with the cursor and clicking. 
Now click the OK button; the result is Figure 3-8. 

This new chart is arresting, but it doesn't make much sense. What does each 
slice represent? And what is the special significance of the slice that has been 

FIG. 3-12 

F11tbnJary 

52 

llfl M.:iilN"dt?r 

D DE«jlff 

II DistribrJtor 

Good: Managing Your Office with Macintosh (Chilton) 

CHARTING YOUR IDEAS AND RESULTS 



FIG. 3-13 
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pulled away at the top? You can answer the first question by adding a legend to 
the graph. Pull down the Chart menu, as shown in Figure 3-9, and select the 
fourth option on the list, "Add Legend." With a legend added (Figure 3-10), it is 
easy to see that the sales for March and April made the biggest contribution to 
profits. 

Unfortunately, the pie chart conceals the "trend" that was evident in the 
previous bar graph. There's a major lesson here: While Chart makes it easy to 
construct a wide variety of chart types, it's up to you to select the type of graph 
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that will get your point across and to add text and labels that will give your point 
the necessary emphasis. 

GETTING YOUR POINT ACROSS 

Chart offers a wide array of chart types subdivided into six categories: bar 
charts, column charts, area charts, line charts, pie charts, and scatter plots. Only 
one or two of these charts will be appropriate in any given situation. Make sure 
you use the right chart for each application. 
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The line chart is invaluable for displaying and comparing trends. And Chart 
can display up to 12 trend lines simultaneously. However, more is not necessar­
ily better. Is Figure 3-11 a line chart or a road map? Five lines is an effective 
upper limit. . 

A line chart or bar chart can be used to exhibit a trend, but the line chart is 
not appropriate when one of the variables is qualitative rather than quantitative 
(when displaying sales dollars by salesperson or sales outlet, for example). 

Bar and column charts can be used whenever one of the two variables is a 
category (male/ female) rather than a continuous variable (0.5-10.0). And they 
are also effective for displaying trends, as Figure 3-6 illustrates. Bar and column 
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charts are particularly valuable when you wish to review the effects of three 
variables simultaneously. In Figure 3-23, for example, overlapped columns are 
used to display sales by sales type as well as by month. 

The pie chart, appropriately used, can be a real showstopper. A pie chart 
with one segment removed immediately directs the viewer's attention to the 
missing segment (see Figure 3-10). The pie chart's chieflimitation is that you can 
display the values of only one variable at a time (and even these must sum to 100 
percent). However, you can display a trend in composition through the use of 
side-by-side pie charts, as in Figure 3-12. (The 100 percent stacked bar chart is 
also appropriate for this purpose.) 
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A primary application for the area chart is to convert sales to sales dollars. 
When the category (horizontal axis) is price and the variable (vertical axis) is the 
number of sales, the area under the curve is sales dollars. You can also use an 
area chart to convert a rate (amps, feet per second) to an amount (watts, feet). In 
the book-sales example, the category is month and the variable is sales fre­
quency, so the area chart represents total sales for the period of the study. 
Warning: The area chart should not be used when the area or integral under the 
curve is meaningless, as in Figure 3-20, where negative values (returns from 
dealers) are incorporated in the plot as if they were positive. 

The scatter plot is the friend of the scientist and engineer, the sociologist, 
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the economist, the marketeer, and anyone concerned with analyzing surveys 
and experimental data. Like the line plot, it can be used whether the underyling 
variables are continuous or discrete or categorical. Linear, semilog, and log-log 
plots are available in the scatter plot gallery. 

Using a series of scatter plots, the scientist can look not only for trends and 
relationships but also "clusters" that indicate the presence of a third or hidden 
variable . A contour plot, which allows the display of three variables simulta­
neously, would be still more meaningful, but it is missing, alas, from Chart's 
gallery. Your next best alternative is to "group" the data on the basis of the 
scatter plot, then use the groups as categories in a bar or column chart. 
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FIG. 3-19 
S File Edit Data Gallery Chart Format 

Mailorder Sales 

1200 

1000 

{?~ 

y 600 

400 

200 

0 
Jan Feb Mar April May June 

x 

EXAMPLE 2: MAKING MULTIPLE COMPARISONS 

Chart's real value can be seen when you want to make multiple comparisons. In 
this example, let's break down the book sales by type-mail-order, dealer, and 
distributor sales-and display the results in the form of line, column, and area 
charts. 

To generate a line chart from the sales data, pull down the Gallery menu, 
select "Line," and click the OK button. The result is shown in Figure 3-13. 

Is there a trend here? Let's find out. First, bring the book sales data to the 
front of the display. Point the cursor at the data box (which is barely visible 
beneath the graph) and click. Next, pull down the Data menu and select "Ana-
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lyze." The list of analyze options includes average, trend, growth, cumulative 
sum, difference, percent, and statistics. Select "Trend." Click the OK button to 
display two sets of points- the original data and a trend line, as shown in Figure 
3-14. 

The trend line reinforces an unhappy feeling that we've been trying to 
avoid putting into words. Although April was a great sales month, sales have not 
kept up the pace thereafter. In fact, the overall trend is flat or slightly down. Is it 
time to get out of the book distribution business? 

The answer won't be a simple yes or no. The sales figures actually include 
three categories: mail-order sales, sales made through dealers, and bulk sales 
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(two of them) made to distributors at a negotiated price. The "trend" is actually a 
mixture of several trends, each moving in a different direction. To illustrate this 
and to help my partners and me to make an intelligent go/no-go decision on the 
book business, let's enter the monthly figures for each sales type and display 
them side by side. 

It takes three steps to enter each set of figures. First, bring the new series 
window to the front of the display by pointing it out with the cursor. Next, 
transfer the original sales data to it from the clipboard using the Paste command. 
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(Actually, you will be throwing away the data, but the transfer saves you from 
having to reenter the names of the months and the axis labels.) Finally, enter the 
revised figures into the sales column. 

The display screen looks like Figure 3-15 after you have copied the original 
sales figures to the clipboard. It looks like Figure 3-16 after you call up the new 
series window, paste in the sales figures, and mark off the first field you wish to 
modify ("350") by dragging the cursor across it. 

Let's enter the mail-order figures first. Type 250, return, 350, return, 350 
return, 400, return, 450, return, 450 return. Note that each time you hit Return, 
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the marker advances to the next field. Use the "Text" selection on the Data 
menu to give the new data set the label "Mail-order Sales." 

By checking the plot series box for each of the two sets of data, you get a 
chart showing both lines (Figure 3-17). Note the contrast between the two lines: 
the mail-order sales, showing slow steady growth, and total sales, with its abrupt 
peak in April. The mystery is clarified when you enter the dealer and distributor 
sales figures using the same three-step procedure you used to enter the mail­
order data. For the dealer figures enter 0, 150, 200, 400, - 50, and - 200. (Those 
last minus figures, alas , represent returns from the dealer of sales already cred­
ited.) For the distributor sales, enter 350 for March and 400 for April; the other 
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months are zero. After you add these latter two sets of figures to the graph, the 
results look like Figure 3-18. 

Horrible. And confusing. For once, a picture isn't worth a thousand words. 
Let's try selecting an area chart from the gallery instead, as shown in Figure 3-19. 
Wrong again. This chart isn't just confusing, it's misleading; it looks as if dealer 
sales are always positive. Figure 3-19 is another reminder that while Chart 
provides a quick and easy way to generate a graph, it does not substitute for the 
brain power needed to select the correct graph type. 
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How can you best illustrate the various counter trends? A pie chart? Yes, 
side-by side pie charts would be quite revealing. But to generate them, you 
would need to return to Multiplan and build a series of spreadsheets by month 
and book type. Instead, let's act on a tip offered in the preceding section and use a 
stacked column chart. 

Figure 3-20 illustrates the gallery of column charts. Number 5, the 100 
percent stacked column comparison, would certainly reveal the changing pro­
portions of the different type of sale. But it would hide changes in the total 
number of sales. This would also be true of the simple column chart (Number 1) 
and the overlapped column chart (Number 4). Number 3, the stacked column 
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chart, yields almost the full sales picture, as shown in Figure 3-21. Almost. The 
problem is that once again the negative sales have become positive. Is there any 
effective way to plot the data? Figure 3-22 reveals the solution. 

THE COMBINATION CHART 

In Figure 3-22, you have overlayed an overlapped column chart (Number 4 in 
the Column Chart Gallery) with a line graph depicting the sales total. It will take 
you just three steps to create a similar combination chart, building on the work 
you've done so far. 
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.- It Doesn't Go without Saying 
Save your work on disk at frequent intervals. Brownouts, power 
surges, and power failures can steal your best efforts. Save your 
work frequently while learning or experimenting. If you make a 
mistake and can't find your way out of it gracefully, you can 
always restart from the point at which you saved your work. 

Save your work on a separate data disk, not on the program 
disk. If you have only one disk drive, you may need to store 
your work on the program disk temporarily, but be sure to copy 
it to a data disk at the conclusion of the work session. 

First, bring the original sales data to the front of the display and check off the 
"Plot Series" box. Edit the order number, just above the Plot Series box, to read 1 
instead of 4. Select "Line" from the gallery. 

Second, bring the graph window back to the front of the display and pull 
down the Chart menu. Select "Overlay Chart Type." The Overlay Chart Type 
menu will appear on the screen; select column from it. 

Third, select "Overlay Chart" from the Format menu. The Overlay Chart 
Format menu will appear on the screen (Figure 3-23). Check the "Overlapped" 
box. Type "30" to set the percent of overlap. Tab to the next field and set the 
percent cluster spacing to "50." Tab again and type "2" to change the number of 
the starting series. Click the OK button. 

CREATIVE FORMATTING 

This chapter only scratches the surface of Chart's formatting potential. You can 
enhance any of the charts you create with grid lines, arrows, legends, and 
comments. You can alter the font, style, and size of any text item. (And you can 
use MacPaint if you don't find enough alternatives on the Text Format menu.) 
You can also rearrange the chart itself, moving titles and legends and stretching 
and compressing the actual diagrams. 

I used many of Chart's advanced formatting features in converting Figure 
3-23 to the chart depicted in Figure 3-24. Note that I've added a legend and 
moved it to the upper right-hand corner, altered the size, style, and position of 
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.- Keep It Simple 
Well-designed visual aids that are part of a well-integrated 
presentation can cut meeting times by up to 28 percent. But the 
secret lies in the design and the integration. A sloppy graph 
with illegible headings and overlying curves can be worse than 
no graph at all. It's up to you to get the most from your graphics 
software. 

Use a chart to make a single point, or two or three interre­
lated points at most. Here is an example: Sales are going up. 
(Point to area curve.) But they're not going up as fast as they did 
last year. (Point to second part of curve where you've used a 
different shading.) 

Let the chart make your point for you. Use a minimum of 
text. Even a flip chart should have no more than two or three 
items per sheet. Don't be afraid to use color, but use it sparingly, 
and use it meaningfully. If you have three curves on a graph, for 
example, two in black and white and one in red, the one in 
color should be the one you want to emphasize. 

Don't be afraid to experiment. Use clustered bar charts to 
show growth and variance, such as an investment yield. Use 
stacked bar charts for budget projections. Pie charts, particularly 
those with a missing or exploded slice, can be used to argue for 
a fair share of the budget. Gantt charts will clarify schedules 
and manpower assignments. 

Make sure that you use the right chart for each application. 
A line chart or a bar chart can be used to exhibit a trend, but 
the line chart is not appropriate when one of the variables is 
qualitative rather than quantitative (when displaying sales 
dollars by salesperson or sales outlet, for example). Area charts 
can be used to track sales volume or dollar growth. But don't 
use an area chart when the area or integral under the curve is 
meaningless. 
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the title, changed the orientation of the label on the Y axis (from horizontal to 
vertical), and selected new patterns for the bars that offer greater contrast. 

To alter the title, "Book Sales for First Six Months," first mark it with the 
cursor. Then, select "Text" from the Format menu and enter the changes noted 
in Figure 3-25. To move the title, point to one of the eight small squares depicted 
in Figure 3-26, and use it to drag the title across the screen. (Experiment to see 
how the different squares drag and stretch the title in different directions.) 

Did I make the right changes? I'll let you be the judge. 
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======================== 

Creating Letters, 
Outlines, and 
Reports 
4 

Every piece of paper or text used in your business can probably benefit from the 
word-processing software reviewed in this chapter: correspondence, case histo­
ries, contracts, documentation, filing guides, form letters, formulations, in­
voices, mailing lists or lists of any kind, maintenance records, memoranda, 
manuals, notes, notices, organization charts, programs, reports, rough drafts, 
schedules, spreadsheets, tables, and telephone logs, to say nothing of address 
books, agendas, agreements, appointment calendars, and articles. 

Word-processing software will save you time and let you produce clean, 
professional-looking copy with minimal secretarial assistance. 

Speed is a major benefit. Minor additions and corrections can be completed 
in seconds and printed without errors at 225 words per minute, about three 
times the speed of a fast, accurate typist. 

You can easily merge contributions from several sources and turn monthly 
reports into quarterly reports and then into an annual summary-all done 
professionally, all printed free of errors. 

Your filing space will be cut drastically. One diskette can hold 30 separate 
documents; three can hold almost the entire contents of this book. 

Word-processing software can also be used to enhance spreadsheets with 
boldface and underline and to add titles, legends, and explanatory notes. Addi­
tional programs used in conjunction with your word processor will let you 
produce mass mailings by merging a form letter with an address list. 
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In this chapter, you learn how to use two Macintosh word-processing pro­
grams, MacWrite and ThinkTank, in four everyday business applications: (1) 
creating and editing a letter, (2) building a document from several documents, 
(3) enhancing a spreadsheet, and (4) organizing an article or a report. In Chapter 
6, you learn how to use MegaMerge with MacWrite to do a mass mailing. 

WORD-PROCESSING SOFTWARE 

Henry Lee, the founder, chairman, and president of Lee Pharmaceuticals of 
South El Monte, California, bought his first desk-top computer so that he could 
gain some familiarity with the concepts surrounding the "large" computer-a 
Basic/Four-that his company had just purchased. Today, Lee Pharmaceuti­
cals owns 50 microcomputers used primarily for word processing. Lee himself 
has two, one in his home and one in his office. The head of data processing and 
the head of public relations each have two. The scientists have them, the sales­
people have them, and the secretaries have them. 

Dr. Lee's first small computer application was word processing. "We have a 
staff of 40 highly talented engineers," Lee said, "but they were always late with 
their reports. Sometimes two weeks of meetings would go by before we'd actu­
ally see the reports we were discussing. 

"I figured, why not eliminate the step of passing drafts back and forth 
between the secretaries and the engineers? We have one fellow who is a Korean 
educated in Germany and another is a Hungarian. In some ways it has been 
easier for them to talk with the computer. 

"Anyway, the experiment worked. The reports started getting out on time. 
And I kept buying more desk-top computers." 

John Crawford, head of Crawford and Whiteside, a firm of surveyors in 
Carterville, Illinois, purchased his desk-top to do engineering designs. After a 
year's experience, Crawford found that a second computer application, word 
processing, more than justified his computer purchase. Crawford lists four con­
tributions the word-processing software made to his business: 

1. Professional, errorless typing 
2. Increased productivity 
3. Major time savings when preparing multiple, similar reports 
4. Reduced pressure on hard-to-find and overworked professional secre­

tarial staff 

Word-processing software is essential for an office that requires profes­
sional, errorless typing. Crawford's survey reports must be error-free since they 
form the basis of legally binding contracts. 
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Word-processing software speeds the preparation of form letters and serial 
reports by letting you take advantage of previous efforts. Crawford says, "Each of 
our reports could easily fill a three-ring binder. With our word-processing soft­
ware, we don't have to retype each report from scratch. It's just a case of chang­
ing a few specifications, or adding a paragraph or two to a previous report. And 
while the report is printing, my staff and I can get started on our next project." 

Your business needs a computer for word processing if it frequently does 
mass mailings or has a need for multiple reports with slight variations. Each 
month, Crawford must transmit copies of the emerging specifications to five or 
six separate government agencies, along with a "personalized" cover letter. This 
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3 December 1 984 

Alan Turner 
Editorial Director 
Chi 1 ton Book Company 
k'.adnor PA 19089 

Dear Alan: 

Enclosed is the biographical information that you requested 
in our telephone conversation last Friday. After a brief 
stint at the Berkely Barb, I went south to the Jet Propulsion 
Laboratory where I applied computerized pattern recognition 

. . . . 

I I 
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is no problem with word-processing software that cuts the time required to 
revise and update the reports. 

A desk-top computer like the Macintosh can reduce the pressure on hard­
to-find professional secretarial staff. Crawford has just one secretary to support a 
staff of twenty. Like Dr. Henry Lee, he has found that the computer lets his 
engineers bypass the typist completely. 

WILL YOU NEED A SECRETARY? 

Whether you can eliminate or get by without a secretary will depend upon the 
type of work she must do. If she is simply a typist who merely reproduces your 
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handwritten copy, you may find you can bypass her completely, simply by 
entering all your correspondence directly at the keyboard. On the other hand, if 
your secretary is truly a paraprofessional, you may want to let her originate 
much of your work. 

The desk-top computer has created a requirement for three types of 
assistant- the typist, the editor, and the paraprofessional. Which types or how 
many of each you need will depend upon your business and the qualifications of 
your present staff. 
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THE TYPIST 

The reason most executives have typists is to ensure that the copy produced 
looks professional. I've known how to type (with three fingers) since grammar 
school, but my typing, with its crossovers and strikeouts, has always looked as 
smudged and illegible as a child's handwriting. Not so since I started using my 
desk-top for word processing. Any mistakes or typing errors I make are corrected 
electronically before I print my work. In fact, the work I produce today looks as 
clean and neat as if it had been prepared by the most professional typist. For this 
reason, I rarely need a typist to help me anymore. 
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When I do use a typist, it is either to enter long lists of addresses or parts into 
the computer or to transcribe old manuscripts that date back to before the 
computer age. 

I once had a crackerjack typist who was barely out of high school, yet she 
could produce flawless, error-free copy at 90 words a minute for hours at a time. I 
hated to let her go, but there simply wasn't enough work to keep her busy. 

THE EDITOR 

In one respect, the Macintosh has not lived up to its expectations. Initially, we 
thought we could edit all our correspondence and reports simply by sitting down 
at the computer. And although we still do some editing this way, it's far more 
satisfactory to sit down with a printed version of a manuscript (a cup of coffee 
and a cigarette) and make corrections in pencil. A printed copy is the only way to 
proofread a manuscript when waiting at an airport or in a doctor's office. A 
printed copy is also necessary when several partners need to review a single 
piece of work, such as the first draft of a contract or a report. 

Once you have made corrections, you still need to return to the computer 
and incorporate them in the electronic copy of the document. This is where an 
editor comes in. He or she needn't understand the contents of a report, but she 
must be capable of understanding the subtleties of MacWrite or Word, our 
word-processing software. She must know whether to insert or delete and what 
the right command is for each. (Hint: Have her work through each of the four 
examples in this chapter as part of her training.) 

THE PARAPROFESSIONAL 

One of the major features of Mac Write and the Macintosh is the ability to merge 
paragraphs and pages from several documents. Portions of this chapter have 
appeared previously in nine reports. Preparation of this chapter consisted of 
merging the nine separate documents into one, selecting the paragraphs that 
were relevant and deleting those that were not, arranging the remaining para­
graphs so as to make them easier to follow, adding new information, then 
smoothing and polishing the rough spots. 

It's the same way with much of my correspondence. Suppose I want to write 
a follow-up letter to Alan Turner, Editorial Director at Chilton Book Company. I 
call up to the display screen and read the last letter I wrote to Alan (see Figure 
4-1). This letter provides me with his correct title and address, along with the 
salutation and closing for my letter, and fills me in on where I left off the last time 
Alan and I corresponded. 

76 

Good: Managing Your Office with Macintosh (Chilton) 

CREATING LETIERS, OUTLINES, AND REPORTS 



Alan asked me to send him a brief biographical sketch to include with some 
publicity he'll be sending out to accompany this book. I use MacWrite's File 
menu to display on the video screen various "canned" biographies I've got 
stored on floppy disks. When I find the one that comes closest to Alan's needs, I 
copy it onto the Macintosh Clipboard and then Paste it into my letter. 

Now, I've been as fortunate in my choice of secretary as I have been with my 
choice of typists. I am able to delegate the majority of my correspondence to her, 
such as this letter to Alan. I simply scribble a few instructions on the bottom of 
each letter, such as "Send him the Rogers file, give him a briefbio, and check my 
appointment file and see if it's his kid's birthday-mention something in a 
postscript," and she, wonder of wonders, does it all. 

Of course, our new electronic file system is a big help too. She doesn't have 
to search through the papers on my desk to find the Rogers file or my appoint­
ment book with a list of birthdays in the back. All the information she needs is 
available electronically on disk. 

My friend and attorney has a similar system in his office for composing 
briefs. He scribbles a few notes indicating which paragraphs he wants to incor­
porate from a previous contract, what standard boilerplate he wants to add (even 
the page numbers of the legal books they are to be found on), and perhaps a new 
paragraph or two he's worked out over the telephone. His paraprofessional 
secretary assembles it all at the computer and hands him as many printed copies 
as he needs. 

Not all secretaries are capable of this type of paraprofessional activity. But 
for those who are, and for those offices that are fortunate enough to employ 
them, word-processing software can be a tremendous boon. 

CREA TING A LETTER WITH MACWRITE 

One of the benefits of a computer in the home is that it allows your children to 
express themselves without too much concern about the appearance of their 
work (at least initially). For example, Figure 4-2 contains a message my six­
year-old left on the Macintosh. As you see, even a six-year-old can create a letter 
with the Macintosh. There are no special commands that need to be entered, 
absolutely nothing you need do that you wouldn't do on an ordinary typewriter. 
In fact, it's easier to use the Mac because you don't need to use a carriage return, 
except at the end of an address line or at the end of a paragraph. 

Crystal's letter contains some spelling and typing errors. Don't panic. Santa 
will understand. To make things even easier for Santa, we'll use MacWrite to 
clean up the spelling and punctuation and add an inside address. 
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_. Getting Started Quickly 
While a minimum of instruction is required to get you or your 
employees started entering labels or transcribing copy into the 
Macintosh, the subtle differences from a standard typewriter 
will confuse most typing professionals. Here are some points to 
stress during your training. 

1. Don't look at the screen as you type, any more than you would 
look down at your paper in a typewriter. 

2. Don't use the return key unless you want to force a new line, 
as in an address label or at the end of a paragraph. There is no 
carriage return, since on the computer your typing will 
automatically wrap around to the next line as the words 
extend beyond the boundary of the screen. There are no bells 
at the end of each line, no pauses while you consider hyphena­
tion, and no margin release. (In fact, if you change your 
margins, the lines will readjust themselves automatically.) 
Your typing speed will increase substantially. 

3. Save your work regularly. How to read and write your files to 
disk are the first and only special computer skills you and your 
typists must learn, and these skills are a must. What you see 
on the screen is only temporary. To keep a permanent record, 
you must save your work on a floppy disk. If you haven't saved 
your work by the time the power is turned off, it will be lost 
forever, even if the power is turned off accidentally. 

To make sure your typist understands the importance of saving 
her work on disk at regular intervals, give this brief demonstration: 

1. Have the typist type one page of material. Save it on disk for 
her, but don't explain what you are doing. Now turn off the 
power to the Macintosh, then turn it on again. The screen is 
blank. Her work seems lost forever. 

2. Read the material back in from disk. Have the typist add a 
second page of material. Now show her how to save her work 
on disk. Have her save it while you watch. Make sure she 
saves it under a different file name than the one you used the 
first time. 

3. Turn the power switch behind the Macintosh off, then turn it 
on again. Now have the typist reload MacWrite and read back 
each of the files that have been saved on the disk. The first file 
will contain just the original page of typing. The second file 
will contain both pages. 

This exercise shows that if you save your work frequently, 
you'll have less to retype in the event of a power failure-a 
good lesson for you as well as your secretary. 



Mr and Mrs Phillip Good 
Mattawan Ml 49071 

Dear Mom and Dad, 

FIG. 4-4 

I would like you to bring me a bunny, a doll, a snow suit, pyjamis with Snurfs on 
them, lots of candy, $5 bill, a camera, a cub hat and a pirate. 

Thanks, Crystal. 

We're going to do three things: (1) type over errors, (2) delete errors, and (3) 
insert letters, words, and punctuation. 

Typing over errors is easy. Use the mouse to mark the part you wish to type 
over. Type, and the new material will replace the old automatically. To mark an 
error, whether a few characters or a paragraph, just move the cursor to the 
beginning or end of the section you wish to mark, hold down the button, drag the 
cursor across the error-the marked area will turn black on the display screen 
- then release the button. 

In this case, we want to change "Daer" to "Dear." Mark off the "Daer" and 
type "Dear." That's it. 

You can delete errors in one of two ways, either by backspacing over the 
error a letter at a time, or by cutting from the pull-down Edit menu. Let's try both 
ways. Eliminate the extra n in "bunnny" by moving the cursor to any of thens 
and pressing the backspace key (in the upper-right-hand corner of the key­
board). Now the word is correctly spelled, b-u-n-n-y. 

Next, take care of the false start "pir." Mark it off with the cursor, then pull 
down the Edit menu and select Cut, as shown in Figure 4-3a. The "pir" is deleted 
and the word "pirate" is moved left to occupy the empty space. 

To insert missing letters and phrases-to turn "wad" into "would," for 
example- takes only two steps. (1) Move the cursor to where you want to make 
the insertion, at the d, and click. (2) Type the missing letters. Now the sentence 
reads, "I would like you to bring me a bunny, a doll, and a pirate." 

To help Crystal get her letter to the correct destination, let's insert an 
address above the salutation. Move the cursor to the top of the text. Type "Santa 
and Mrs. Claus," press Return to force a line break, type "North Pole, Canada," 
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and press Return twice to insert a blank line between the address and the text. 
The result is shown in Figure 4-3b. It's a letter any six-year-old would be proud 
of. (But what does she mean, "bring me a pirate?") 

A WORD OF CAUTION 

As you type, you may notice the new text pushing the old text ahead of it on the 
display screen. Stop looking! Professional typists never waste their time looking 
at the display screen anymore than they waste it looking at the keyboard. The 
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a snow suit, pyjamis with Snurfs on them, lost of candy, $5 bill, a camera, a 
cub hat 

1§0 Clipboard ==· 

la snow suit, pyjamis with Snurfs on them, lost of candy, $5 bill, a 
~amera, a cub hat 

'Qt 

only time you need to look at the display is when you proof your text, make 
editing changes, and format your text-altering the margins, justification, and 
spacing-just before you print it. For now, just type as fast as you can. You can 
always correct errors when you are finished (without leaving a smudge in their 
place) by typing over, backspacing, cutting, or inserting. 

(If you still look at the keyboard as you type, MacType and MasterType will 
help you learn touch typing. See Appendix I for a complete review of these and 
other popular Macintosh programs.) 
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MERGING DOCUMENTS 

On a typical working day, most small businesses need to send out several similar 
letters with minor modifications to fit the needs of the individual customer. In 
the old manual way, you looked through your files until you found a letter 
similar to the one you wanted, scribbled a few changes, tacked on the new 
address, and gave it to a secretary to type. In the new, computerized way, your 
"files" are stored on magnetic disks. You can display or recall your letters or 
documents to the screen whenever they are needed. You can make all the 
necessary modifications yourself and print out the letter as soon as you are done. 

FIG. 4-7 
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santa and Mrs Claus 
North Pole, Canada 

Thanks, Crystal 
I 
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FIG. 4-8 

The second and third letters you prepare on your Macintosh will be even 
easier than the first. This is because you may use the first few letters as tem­
plates. The letter in Figure 4-4 is a good example; it's identical to the preceding 
letter, with two exceptions: This time Crystal's parents are the recipients rather 
than Santa, and the list of gifts seems to have grown considerably. 

There's something suspicious about this new list of gifts-not just the $5 
and the camera, which were presents Crystal's older sister wanted, but the way 
in which the new items have been inserted into the body of the letter. "How did 
you get such a long list?" I asked Crystal. 

"Well," she replied, giggling, "first, I saved my letter on disk the way I'm 
supposed to. Then I started a new list on the computer. Whenever I thought of 
something I wanted, I typed it on the new list." 

"What about the $5 bill and the camera?" 
"Those were on Barbara's list," she said, referring to her older sister. "When 

I was all through, Barbara took my list and her list and popped them both 
together in my letter." 

Crystal and her sister had done three things: First, they saved the original 
letter. Second, they created a new document, copied it to the Clipboard, and 
saved it. Third, they recalled the original document and pasted the new docu­
ment within it. 

These are the same steps you would follow if, after having hammered out an 
agreement over the telephone, you found you had to go back and add several 
additional paragraphs to your letter or contract to cover various unanticipated 
contingencies. 

SAVING A FILE 

Let's go over these three steps. First, create and save a list of gifts. (Or you could 
create and maintain a list of "Things we've got to start doing around this office if 
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.- Backing Up Your Files 
Back up (store) your work on disk as often as possible. Text 
created with Mac Write is stored in Macintosh's internal memory 
as long as the power is on. This storage is not permanent; if 
power to your system is interrupted or turned off, anything in 
its memory is lost. Save your files on disk so that you can recall 
them in the future. 

Back up the disk itself to guard against vandalism and 
accidental destruction. Make it a practice to back up all your 
files from one disk to another at the end of the day. Do not store 
documents on your MacWrite program disk! You may use this 
disk for temporary storage, but copy them to a second data disk 
at the end of the day. 

When Mac Write saves a file, it writes on top of the original 
file. It's a good practice to keep a backup of the original in case 
you change your mind. You can do this by naming each succes­
sive version of a letter or report Crystall/11, Crystal4/11, and 
so forth. Periodically, go through your files and destroy older 
versions that you no longer need. 

we're going to make any money," or a list of the telephone numbers and ad­
dresses of sales prospects, or a list of pedigreed horses with solid records on 
muddy tracks.) If you are starting fresh, just load Mac Write into the computer. If 
you're continuing from where you left off with the last example, you will have to 
save the Santa letter before you can enter the new material. Pull down the File 
menu and select "Save as ... "Now the display screen looks like Figure 4-5. 

Type in a name for the new file. How about "Crystal's letter to Santa?" If you 
have two disk drives on your Macintosh, make sure you switch to the second or 
data drive. If you have only one disk drive, remember to copy this letter from 
your program disk to your data disk before you quit for the day. 

As soon as the save is complete, control of the cursor will be returned to you. 
Now select "Close" from the File menu and, when the screen clears, pull down 
the File menu once more and select "New." 

84 
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John: 

Here are the book sales figures for the last six months. Altt1ough the total 
($3600) meets our expectations, sales have been dropping in the last 
couple of months. Maybe it is time to quit? 
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Once again, you have a blank screen to write on, with a ruler (for the 
margins) at the top of the screen. Type in your list. In this example, we use 
Crystal's list of gifts: 

a snow suit, pyjamis with Snurfs on them, lost of 
candy, $5 bill, a camera, a cub hat 

(If you insist on cleaning up the spelling, or making your own list, go ahead.) 
Next, copy this information to the Macintosh Clipboard. First, mark the text 
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you wish to copy by dragging the cursor across it. Then pull down the Edit menu 
to "Copy." Pull down the Edit menu again to "Show Clipboard," as in Figure 4-6. 
Last, to protect yourself against the possibility of a power failure, save the list 
you've just created under a new file name, say, "Crystal's Wish List 1984." 

INSERTING THE LIST 

Now you can read in the original version of Crystal's letter that was saved on 
disk. Select "Close" from the File menu. When the screen clears, select "Open." 
Mac Write will display a list of the files you have displayed on disk. These should 
include Crystal's Letter to Santa and Crystal's Gift List '84. 

FIG. 4-10 
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FIG . 4-11a 
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Double-click "Crystal's Letter" with the cursor. After a moment (while the 
letter is being read in from disk), the display should look like Figure 4-3b once 
more. Now, paste the contents of the Clipboard into the letter. Move the cursor 
to the space just after "doll" and click. Pull down the Edit menu and select 
"Paste." The letter now looks like Figure 4-7. 

You can see that just as the Macintosh Clipboard provides a convenient way 
to move data between Multiplan and Chart, it provides a very handy way to 
insert standard boilerplate into a contract or build an annual report out of a 
series of monthly ones. 
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ENHANCING A SPREADSHEET 

Many accountants and managers use a word processor to enhance their spread­
sheets with underline and boldface, and to add titles, footnotes, and annota­
tions. By using the Macintosh Clipboard, you can transfer a table from Multi plan 
to Mac Write and embed it in the text of a report you are writing. And you can use 
MacWrite to add emphasis to portions of the table with underline, italics, and 
boldface, as well as add headings and legends in a variety of type fonts and styles. 

Figure 4-8 depicts the report on book sales that was prepared in Chapter 2 
with Multiplan and used to create charts with in Chapter 3. Return to Multiplan 
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John: 
Here are the book sales figures for the last six months. 

Although the total ($3600) meets our expe<:tations, sales 
have been dropping in the last couple of months. Maybe it 
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As al-ways, I rely heavily on your judgement. I still think 
the book is good, but perhaps its distribution does leave 
something to be desired. 

Phil 
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and copy these data to the Clipboard. (The procedure is similar to that used in 
Chapter 3 to copy to Chart.) Quit Multiplan, load MacWrite, and paste the 
contents of the Clipboard to the screen. 

The result looks like Figure 4-9. Well, it almost does. Obviously, I made a 
few changes on the table first. I added a paragraph of text at the beginning and set 
off the total with boldface and underline. (Boldface and underline are two of the 
options you find when you pull down MacWrite's Style menu. The other options 
include italics, shadow print, subscripts, superscripts, and a variety of type sizes 
from tiny to gigantic-9 point for accountants, 24 point for headlines and the 
visually impaired.) 
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FIG. 4-15 
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There are two problems with the report as it appears in Figure 4-9. The gap 
between the two columns of the table makes it difficult to line up the sales 
figures with the corresponding months. The sales figures are lined up under the 
dollar sign, rather than under the decimal point. 

You can move the columns closer together simply by changing the tab 
setting in the ruler at the top of Figure 4-9. To shorten the distance between the 
two columns, drag the tab marker (the open triangle between the 5 and the 6) 
across the ruler until it lies halfway between the 2 and the 3. Use the backspace 
key and the space bar to line up the sales figures and delete unneeded dollar 
signs. The result looks like Figure 4-10. 
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.- Using MacWrite's Rulers 
MacWrite's rulers make it easy to modify the appearance of 
your text simply by changing a setting or shifting a tab or a 
margin on the ruler. And you can format different parts of the 
text individually by inserting additional rulers. 

The added rulers can create problems when you want to 
make a formatting change that affects the entire text. If you 
want a narrower format, for example, you must shift the margin 
separately on each one of the rulers, a time-consuming process. 
To eliminate an unwanted ruler-all but the top-most, which 
cannot be removed-mark it with the cursor. It will turn black 
just like a marked section of text. Next, pull down the Edit 
menu, and select "Cut." You can use the Format menu to hide 
the rulers, which will make the text easier to read, but you'll 
have to unhide them in order to change a margin or a tab. 

You can also use the ruler to set the left and right margins, paragraph 
indents and tabs, to change from single to double spacing, and to center and 
justify the text. And you can insert several additional rulers in order to format 
different parts of the text differently. Here is one example: 

To set the table off further from the text of the report, you can put it in 
somewhat smaller type and center it on the page. To put the table in 9-point type, 
mark off the table with the cursor, then pull down the Style menu and set the 
typesize of the marked-off portion to 9 point. 

To center the table but not the text, move the cursor to the top of the table, 
pull down the Format menu, and select the first item, "Insert Ruler," as shown 
in Figure 4-lla. Next, select the centering option on the ruler (third from the 
right, as shown in Figure 4-llb). 

To narrow the right margin, move the black filled-in triangle to the right of 
the ruler from 7" to 5%". 

You can use any number ofrulers in reports and format each section indi­
vidually to get exactly the appearance you want on the printed page. For exam­
ple, in Figure 4-12, a third ruler is used to justify the text that follows. Mac Write 
inserts spaces into justified text so that the two margins line up evenly both on 
the right and left. The final printed result, sans rulers, is shown in Figure 4-13. 
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FIG. 4-16 
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PREPARING LONGER REPORTS 

At first glance, it seems that to prepare longer reports and documents, you need 
only repeat what you have learned so far over and over again. Enter text anq 
tables as fast as you can type, type over and delete errors, insert new text as ideas 
strike you, and move paragraphs from one part of the text to another (using the 
Cut and Paste commands from the edit menu). 

In actuality, the preparation of a long report is far more complicated. A long 
report usually involves an intricate series of concepts, rather than one or two 
simple ideas. To be successful, you must spend as much time organizing your 
ideas as in writing and editing them on paper. 
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CREA TING AN OUTLINE WITH THINKTANK 

Fortunately, you have another Macintosh software tool to help you organize 
your ideas. ThinkTank 128 lets you juggle ideas and concepts with the ease that 
Mac Write lets you organize words and phrases. ThinkTank is a headline organ­
izer. You type in your main ideas, manipulate and rearrange the outline, and 
add headings and subheadings until the entire complex series of ideas is com­
pletely under your control. A major feature of ThinkTank 128 is the ability to 
hide or reveal any part of your outline quickly and easily by switching from the 
details of one section to the big picture and back again. 

My first application for this powerful computer program was to prepare a 
table of organization (and later the table of contents) for this book. I began by 
typing in a list of the topics I thought should go in the book: 

word processing 
spreadsheet 
1001 uses 
data management 
mass mailings 

Almost as soon as it was entered into the computer, I began to modify the 
headings, add new ideas as they occurred to me, and change the way they were 
organized. I must have changed the arrangement a dozen or more times until I 
knew it was "right." All this preparation may seem time-consuming even with 
ThinkTank's help, but it paid off when I sat down, finally, to write this book. 

ORGANIZING WITH THE CURSOR 

To illustrate ThinkTank's simplicity and potential value to you, let's convert my 
initial list into the final, complete table of contents. First, load ThinkTank into 
the computer. The word "untitled" will appear at the top of the screen. Back­
space over this word to erase it and in its place type "Managing an Office with a 
Macintosh." Now press Return and enter the list that appears above. (Press the 
return key between each topic or thought.) 

The real power of ThinkTank is that you can write down your thoughts as 
they occur, without having to worry about whether they fit into some precon­
ceived structure. For example, one of the entries in my list, "1001 uses," is not a 
chapter heading but a comment about spreadsheets. Its subordinate status is 
shown in Figure 4-14, where it has been indented. To indent a heading, point to 
it with the cursor: hold down the button, move the cursor to the right, then 
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release the button. Note that the minus sign to the left of the heading immedi­
ately above changes to a plus sign. Headings and subheadings that have subordi­
nate ideas attached to them are always marked with a plus sign. 

If you had decided to use the spreadsheet as the initial topic, you would 
transfer the word spreadsheet to the top of the list, point to it with the cursor, 
hold down the button, and continue to hold it down as you drag the heading to 
the top (see Figure 4-15). 

"Graphs and charts" is an important topic that was omitted from the first 
list. To insert the heading "chart" just after the heading "spreadsheet" takes two 
steps. First, hide the subheadings. Point the cursor to the word spreadsheets and 
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.- Editing with ThinkTank 
We all make misteaks. Fortunately, ThinkTank 128 puts all the 
correction tools of Mac Write at your disposal, plus some of its 
own. You can edit a headline by backspacing or by marking and 
typing over. You can remove unwanted lines by cutting. And 
you can easily rearrange the order of lines just by moving them 
with the cursor. 

In one instance, if you put a subheading under the wrong 
heading by mistake, it can take five steps to relocate the sub­
heading correctly: (1) Use the mouse to move the subheading to 
the top as far as it can go. (2) Shift it left to convert it to a head­
ing. (3) Move it up or down until it is located under the correct 
heading. (4) Shift it right to convert it back to a stepheading. (5) 
Move it up or down until it is located correctly. 

double-click. The subheading "1001 uses" vanishes. A plus sign remains next to 
the word spreadsheets to tell you there is at least one "hidden" subheading. 
Second, open up a space for the new heading as in Figure 4-16. To open a space, 
click the cursor at the end of the preceding line (here just after the word spread­
sheet) and press Return. Type "charting your results" in the space you created. 

Now let's go back and plan the chapter on spreadsheets in detail. Point the 
cursor to the spreadsheet heading and double-click. It expands to reveal "1001 
uses." What other subtopics should you include? Type Multiplan [return], a 
sales analysis [return], tracking expenses [return], manpower assignments [re­
turn], building a graph [return], increasing your productivity [return]. After 
indenting four of the subheadings under Multi plan, the display looks like Figure 
4-17. You could continue adding subheadings in this fashion chapter after chap­
ter until you have reproduced the entire table of contents. 

OTHER THINKT ANK APPLICATIONS 

ThinkTank has a number of advanced features like "sort" and "search" that can 
help you with many of your other office applications. For example, you can use 
ThinkTank to create lists of telephone numbers and addresses, sort them alpha-
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betically with one ThinkTank command, and search for a particular telephone 
number with a second command. I use ThinkTank for my "Things to Do This 
Week" list. I type in the list just as fast as I can think of things to do. Then I go 
back through the list, slowly rearranging the items with the cursor into some 
kind of order and priority. Like everything else I do with my Macintosh, the final 
list is smudge-free, and I can print one copy or half a dozen copies for each of my 
employees. 
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======================== 

Creating Lists of 
Clients and 
Prospects 
5 

In this chapter, you learn how to use the Macintosh to create lists of clients and 
prospects, catalogs, and equipment manifests. Once you discover how easy 
computerized data management can be, you'll find thousands of applications for 
your new computerized filing system, ranging from a simple directory of tele­
phone numbers and addresses to a comprehensive system for maintaining 
orders, customer records, and an inventory of parts. 

A computerized data manager lets you organize your data into an integrated 
system of files from which you may quickly retrieve the information you need. It 
provides for the type of comprehensive cross-indexing you've always wanted 
but never quite had the time to put into practice. Benefits include the quick 
retrieval ofinformation, the ability to create a variety of different reports to meet 
varying needs, and storage ofe_ssential data in a compact format. But the over­
riding advantage is that you regain control of your office. If you make a rule that 
an invoice must accompany every order, that rule will be adhered to. If you 
receive a customer inquiry, you can respond immediately. If you wonder which 
items are slow moving and which show a rising demand, you can have the 
answer now. 

Data entry is simplified because you can use the graphics capabilities of the 
Macintosh to create a multipage form almost identical to the one you're now 
keeping on file cards. You can add or delete items to the form or switch them 
around with a touch of a button. The names of the fields-author, title, journal, 
for example-are displayed on the screen along with their values. This means 
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that once you have created the form, you can have someone who knows little or 
nothing about the subject fill in the blanks. 

When you or your employees fill in an item on the form, tabs advance you 
automatically to the next field. Within each field you have full editing capability 
and may delete, type over, or add material. As you complete each form, it is 
stored automatically and correctly in a data file on disk, and is replaced by 
another form on the screen for continuing data entry. 

When you go to retrieve the information you need, you can easily select and 
display all your prime customers or the names and locations of salespersons who 
have exceeded their quota. Suppose you want to send a test mailing to potential 
customers on the West Coast. Use the Macintosh file-management program to 
order all records by Zip Code and then select a subfile of customers with Zip 
Codes between 90000 and 99999. 

A real estate agent uses her Macintosh and a map of the local area to keep 
track of listings. A wine connoisseur indexes and displays the contents of his 
cellar, bottle by bottle. I've used the Macintosh to catalog my collection of cables, 
screws, memory boards, and other replacement computer parts. I also use it to 
maintain lists of customers, orders to date, and prospects for future sales. You 
can cross-index your books and recordings by artist, composer, label, and title. 
And you can locate the exact spot where each is to be reshelved. It is easy, and 
you learn how in this chapter. 

Traditional business applications for computerized data management in­
clude client and prospect information, personnel files, equipment maintenance 
schedules, experimental and quality-control observations, inventories, medical 
records, orders, payroll, product specifications, and investment tracking (see the 
sidebar for a host of other applications). But there's no need for you to be 
traditional. Every business can find its own specialized applications for a data 
manager. 

INFORMATION AT YOUR FINGERTIPS 

"You don't need to be a programmer to create a data-management system," says 
Steve Cornell, director of marketing for the Cincinnati-based Hamilton Safe 
Company. Hamilton Safe is a small firm, but one that is significant in its own 
industry. The data-management system Cornell wrote for his firm is used for 
order entry, tracking work in progress, and evaluating sales trends. 

"Building a data base is really quite simple if you have the right software," 
Cornell says. "You can do everything you want to do with a few simple com­
mands. I built one or two of the data-entry screens just to see how it was done, 
and the office personnel built up the rest. 
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..- 78 Uses for a 
Graphics List Manager 

Abstracts of interviews 
Active job seekers 
Applicants and their preferences 
Appointments and a desk-top 

calendar 
Anatomical charts 
Bibliographical data 
Bird identification and classification 
Bird sightings 
Birthdays 
Birth records 
Books by title and shelf location 
Case references 
Catalog of programs 
Chess openings 
Client and prospect information 
Client requirements 
Company histories 
Cross-index of recordings 
Customer addresses 

Daily observations 
Diary of past attendance and ap-

pointments 
Employee numbers 
Equipment maintenance schedules 
Experimental observations 
Feeding and watering schedules 
Feeding and medication schedules 
Freight schedules 
Important dates 
Index of recipes 
Index of periodicals 
Information about competitors and 

opponents 
Inventory by bin and rack 
Key accounts 
Lists of supplier materials 
Lists of chemicals by storage location 
Lists of contracts 
List of hotels 

"Now suppose someone walks into the office and wants to know quickly 
how many model 4440 locks we sold last August and which dealer sold the 
most? The clerks can walk over to the computer and get the information. It will 
take them one or two commands at most." 

FILEVISION: BUILDING FILES OF PROSPECTS 

In this chapter, you learn how to use Filevision for the Macintosh to maintain 
your records. Step by step, you learn how to build a file of customers, how to 
search the file for the information you need, and how to print reports, including 
a phone directory and a set of labels for a mass mailing. And you get a head start 
on other data-management applications with a review of Filevision's advanced 
capabilities and suggestions for their application. 
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List and locations of restaurants 
Lists of applications 
Livestock records 
Mailing labels 
Maintenance records 
Managing an apartment house or a 

residential hotel 
Marching-band choreography 
Material lists 
Medical records 
Membership lists 
Names and relationships 
Payroll information 
Periodical and book references 
Phone numbers and addresses 
Playbook (for athletics) 
Prescription-renewal information 
Production specifications 
Quotations 
Rate-card information 
Raw-material requirements 
Real-estate listings 
Records on suppliers 

Sample tracking 
Seating charts 
Serial numbers of production runs 
Sermon topics on calendar display 
Service log 
Shelf catalogs 
Shopping list 
Software directories 
Staging directions 
Strengths and weaknesses of teams 
Strengths and weaknesses of players 
Student grades 
T-bill and option expiration dates 
Team stats 
Technical specifications 
Theorems and formulas 
Tickler files 
Time cards 
Track commodity contracts, calls, 

and common stock 
Track manuscripts 
Transactions with tax effects 
Trivia 

You begin by using Filevision's graphic capabilities to make a drawing or 
map of the sales area with the locations of your customers and prospects. You 
sketch a data-entry form directly on the display screen, similar to the records 
you may be keeping now on 3 X 5 or 4 X 6 index cards, with the telephone 
number of each prospect, address, nature of business, estimated buying power, a 
record of past sales, and any other data that can help you make a sale. Then you 
complete a data-entry form for each prospect. Now, you can display your find­
ings on the map, display or print a list of prospects and a routing for tomorrow's 
sales calls, create a telephone directory, and print a set of ~ailing labels. 

USING FILEVISION 

To get started on the first application of your new filing system, bring your 
address book or a handful of filing cards to the computer table. Insert the Filevi-
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sion disk in the drive and turn on the Macintosh. (If you already have a disk in 
the Macintosh, eject it by double-clicking the mouse button as soon as you turn 
on the computer. If you own a second disk drive, put your data disk in it.) 

You could use Filevision's many drawing tools to create a street map of your 
sales territory or a bin-by-bin description of your inventory. We begin the easy 
way by using a map of the continental United States that is already provided on 
the Filevision disk. Since a power failure could destroy this file (see the sidebar, 
"Protect Your Data," at the end of the chapter) take the time to copy this map to a 
data disk first. (For details of the copying process, see pages 66-67 of the Macin­
tosh owner's manual.) 

FIG. 5-1 
s file Edit Types Tinker Te Kt Symbols Lines Shades 

---
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Continental United Stutes 

( Prev) (Next) State: California 
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FIG. 5-2 

Information for this State: 

( Concel J r Preu ] ( NeHt ) ( Done ) 

Once you 've made the copy, point to the file labeled "Map" on the screen 
and double-click the mouse button. 

Now the screen looks like Figure 5-1. On the left of the screen, in a vertical 
column, is the Filevision graphic toolkit. The menu bar is overhead. And a map 
of the United States, divided into states, fills the center of the screen. 

There are nine different headings on the menu bar. Take a moment to pull 
down each menu to see its subheadings. Some of the options are familiar; for 
example, those under "Text," "Lines," and "Shades." Some options are unique 
to Filevision, such as those listed under "Types" and "Tinker." Two categories 
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FIG. 5-3 

Definition for this type: 

Type-name ~ 

(Cancel J ( Rdd Field ) ( Done J 

of data are already listed under Types: Background and States. Let's add a third 
category, "Clients." But first, let's run through the display procedure. 

Pull down the Types menu and click the States type. Release the Types 
menu and move the cursor across the map until it points to one of the states. If 
you double-click the mouse, you will see a display of information about the state 
you have chosen (Figure 5-2). (Click the Cancel button in the lower-left corner to 
leave the information display and return to the map.) 

To create a similar display of information for clients and customers will take 
three steps. First, you must create a new "type" called "Clients" (or "Cus­
tomers" or "Prospects"). 
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IF Creating the System 
Creating a data-management system with Filevision or any 
other computer program requires four simple steps. 

First, decide what reports you would like to have. You don't 
need precise specifications-a general idea will do. A good 
data-base manager (and not all advertised products fall into this 
category) will let you add or delete variables at any time, even 
after the data base has been constructed. Now is the time to 
decide exactly what information you require from your business 
needs. Hint: Don't just copy your old reports, although if you 
require the same information, try to preserve the same format. 
Maybe you've been skimping on the reports you need because 
the information was hard to retrieve. With a computerized 
system, data retrieval is no longer a problem. So design your 
reports to meet your needs, not according to the time that is 
available. 

Second, outline a series of data-entry forms. You can save 
time by working directly at the terminal rather than doing 
rough work on a sketch pad beforehand. Hint: Keep your 
data-entry forms similar in format and content to those you are 
already using. This will keep training time at a minimum later. 
You know what data you need to collect because you designed 
your reports first. 

Third, enter some preliminary information, say, ten com­
plete forms, into the data base. It is difficult to add or delete 
fields once a data base has been established. Now is your last 
chance to ensure that the data you are entering will produce the 
reports you need. 

Fourth, design your reports in their final form. This is 
something you can do completely on your own, without pre­
vious computer experience. 
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FIG. 5-4 

Definition for this type: 

(Cancel J ( Rdd Field ) ( Done J 

Pull down the Types menu and click "Add Another." The display shown in 
Figure 5-3 appears on the screen. At the top of the display, there is a field called 
Type-name with the entry Type C. To replace this entry with a type name of 
your choice, just type Clients (or Customers or Prospects). 

Second, sketch a data-entry form for clients. Three fields are already pro­
vided on the form: Type-name, Name, and Link. Add a fourth field, Phone. Click 
"Add Field" at the bottom of your screen. As you move the cursor onto the form, 
it will take the shape of a hand with a pointing finger. Use the finger to point to 
the location on the form where you would like to enter the phone number. 
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(Hint: You may already have a set of forms you complete by hand; try to use 
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the same layout on the Macintosh; this will cut down on the time it takes you 
and your staff to become accustomed to your new computerized system.) Click 
to fix the lo ca ti on of the new field and type ''Phone.'' Finished? Move the cursor 
from the field and click again. Now the display looks like Figure 5-4. 

EDITING THE FORM 

You don't like the appearance of the form. The phone number is too far down 
and too far to the right. Move the cursor back to the Phone field and click. Two 
handles appear, one above and one to the right of the field. Move the cursor to 

Information for this CLIENTS: 

(Cancel J ( Pn~u ) 
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FIG. 5-6 

Edit Types Tinker TeHt Symbols Lines Shades 

D 
0 

( Prev) (Next) CLIENTS: 

the top handle. Click again to catch the handle, then move the cursor and the 
field to its new location, as shown in Figure 5-5. (What does the handle on the 
right do? Experiment to see.) 

Similarly, add fields for a street address, city, state, and Zip Code. Is there 
more information on your present record? Feel free to add data-entry areas for 
birthdays, customer preferences, sales volume, sales in past years, number of 
employees, and any other information you feel is important. If you fill the 
display, you may scroll downward to an empty area. Simply move the cursor to 
the down-pointing arrow in the bottom-right corner of the display and click. 
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You can record approximately two screens of data for each client-about what 
you could put on a 4 X 6 file card. 

Finished? Click the ''Done'' box. If you need to make changes later - to add, 
delete, or move a field-just select "Change Form" from the Tinker menu. 

MAPPING THE TERRITORY 

Last, let's locate clients and prospects on the map of the United States. The 
completed map will help in assigning sales territories, planning sales trips, and 

DName 
D Link 
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FIG. 5-7b 
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so forth. Begin by choosing a map symbol to represent each client in the file. Pull 
down the Symbols menu, for a display of 20 predefined symbols. Or you could 
create your own symbols with the Symbol Editor (located on the File menu). For 
this example, however, let's use the symbol of a person in the upper-right 
corner. Click this symbol to transfer it to the fourth box of the graphics toolkit at 
the far left of the screen. To add a client to the map, move the cursor to the 
toolkit, click the person symbol, then move the cursor to the desired location on 
the map and click again. 

110 

Don't worry about locating each client's address precisely, particularly on a 
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map of this scale. If you need more detail, a Filevision technique called linking 
will allow you to locate your prospects on detailed maps of each specific area. 

For example, many of my best customers are located in and around Los 
Angeles. I drew a map of Los Angeles on a disk in my office that I have linked to 
the U.S. map (see Figure 5-6). When I need an additional level of detail, I click the 
Link marker in the lower-right corner of the display to transfer to the more 
detailed L.A. area map. (You may want to stop now and create a map of some 
area that is of interest to you. Use the "New File" option on the File menu and 
the "Background" data type on the Type menu. Check the Filevision manual for 
details on the use of the drawing tools and the link command.) 

FIG. 5-8 
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FIG. 5-98 
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ENTERING THE DATA 

After you have located several clients on the sales map, you can begin to enter 
data for them. To enter data for a client, point to the corresponding symbol on 
the map and double-click. The entry form you created a moment ago will appear 
on the screen. You shouldn't have any trouble entering the data, but in case you 
do, here are a few hints. 

After you fill in one field-the client's name, for example- use the "Tab" 
key to jump to the next field. When you finish entering the data for one prospect, 
click the area marked "Next" to advance to the next blank form. Use "Done" 
only when you finish entering a series of addresses. 
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SEARCHING FOR PROSPECTS 

Now it's time to use the file you have created. Suppose you are planning a trip to 
the Los Angeles area. You have only a limited amount of time, so you want to be 
sure that you call on all the prime prospects. You begin by "highlighting" these 
prospects on your area map. 

Pull down the Tinker menu and select (click) "Highlight some ... " to 
yield the display in Figure 5-7a. You have already used the options in the box on 
the left to specify that the Zip Code of a highlighted client must be greater than 
90000 and less than 93600 (the Los Angeles area). Now, let's add the requirement 
that in order to be highlighted a client have sales in excess of $10,000. To get the 
results shown in Figure 5-7b, touch the cursor in succession to the following 
options: 

Sales 
is 
> 

Then use the keyboard to enter the dollar figure: 

$10,000 

When you return to the display, your prospects are highlighted on the map as in 
Figure 5-6 and you can begin to plan your itinerary. 

USING WILDCARDS 

Let's look at another use for the "Highlight some ... "command before we go 
on our trip. There is a Bob Mac-something I spoke to briefly on our last visit. I 
really should talk with him again, but Mac-what? I'm sure he's of Scottish 
descent, but that's not much of a clue. Fortunately, I can find him with Filevi­
sion's help. Again, I display the "Highlight some ... "menu. This time I ask 
that Name is= Mac .. where I type the part of the name I remember, "Mac," 
followed by two periods. The periods stand for the characters I don't remember. 
In a moment, the names MacPherson and MacTavish are displayed on the 
screen. Bob MacTavishl That was his name. 

PRINTING THE RESULTS 

Not only can you display your list of clients on the screen, but you can print 
them out in three different formats: Info, Label, and List. You can print all or 
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Foster, John 
Gantua, George 
Murray, Dave 
Franks, Bill 
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Phone 

818/360-5643 
818/556-9093 
805/962-3333 
213/549-0553 

City 

Pacific Palisades 
Palos Verdes 

Thousand Oaks 
Westwood 
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some of the records (the latter by printing after you have used the "Highlight 
some . . . "command), and you can have the output ordered by Zip Code, dollar 
volume, or any other field that appears in each record. 

Info format provides a reproduction of the form exactly as you see it on the 
screen. Label format includes on-screen rulers so that you can match the size of 
preprinted forms (Figure 5-8). 

We need a list report in the form of a telephone directory for our trip to the 
West Coast. Choosing "Print list ... " from the File menu yields the display 
shown in Figure 5-9a. After I select the data I want and rearrange the layout of 
the report, the screen looks like Figure 5-9b. 

Several options are available for each list report. To see them, select "Print 
list ... "from the File menu. You can specify how the output is to be ordered. 
Alphabetically? By Zip Code? By dollar volume? I chose city. You can specify 
what variables are to appear on the report and how wide each report column is 
to be. I chose name, phone, and city. You can also provide for a heading and a 
footing at the top and bottom of each page of the report. The result of my own 
choices, a list of phone numbers arranged by city of clients in the Los Angeles 
area, is shown in Figure 5-10. 

OTHER FILEVISION CAPABILITIES 

We've actually just scratched the surface of Filevision's capabilities. And our 
sample data file is only one of many ways that you can profitably put computer­
ized data management to work in your office. In the next few sections, you learn 
more about some of Filevision's advanced, almost futuristic capabilities and 
how you can apply them to your own business needs. 

Because each item in your data base is keyed to a drawing, you can set up an 
inventory-control system based on the exact location of an item as well as the 
part number. (Details for setting up an inventory-control system are given in 
Chapter 7.) 

A supplier can use Filevision's Link command to tie several files together 
-orders, customers, and parts. Ditto for a mail-order operation out of your 
home. A secretary can track her correspondence on a drawing that resembles 
the typical filing cabinet (Figure 5-11). Arealtorcanitemize her listings ona map 
of the local area, then use the Link command to provide a floor plan with 
room-by-room details for each listing (Figures 5-12a and b). (Warning: This 
system works best in a tract that uses three or four standard floor plans.) 

You can create an appointment calendar, sketching it on the screen by 
month, week, and day, and use it to maintain client and prospect information, 
record your activities for tax purposes, and maintain a tickler file of callbacks. 
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~ Protecting Your Data 
WARNING: A power failure or brownout will destroy the file 
you are working on. Unlike the other Macintosh programs 
you've studied so far, the information needed to extract infor­
mation from a Filevision file is kept in memory until you "quit" 
the program. A power failure or even a brief interruption in the 
power flow will result in a loss of the memory's contents and 
the loss of the file. (The file will still be on the disk, you just 
won't have the "keys" you need to unlock it.) 

There are three preventive measures you should take: 

1. Never turn off the power while you are working with Filevision. 
Always save the file you are working on and exit the program 
(Quit on the File menu) before you stop work. 

2. Always work with a backup copy, never with the original. If you 
do not want to risk losing intermediate changes, back up your 
data disk after each use. 

3. If you make almost hourly use of your data files-for order 
entry for example-purchase a backup power supply. (The cost 
is about $400 for twenty minutes of reserve power.) Protect the 
Macintosh itself with a surge protector (about $49). If you have 
heavy equipment elsewhere in the building, be sure your 
computer draws power from an entirely separate source. (Yes, 
you may have to change the wiring in your building. You may 
even need to have the local electric company run a new power 
line to your house.) 

You can develop a work-order control system so that work orders and 
planned maintenance no longer fall through the cracks. Your system can pro­
vide for planned maintenance-daily, weekly, bimonthly, or semiannual 
scheduling-up to six months in advance, plus work orders and equipment 
histories. 

You can have a variety of different data types in each data base-upto 16in 
all-to represent various categories of objects, such as resistors, capacitors, 
amplifiers, and rectifiers for electronics applications, and chairs, tables, sofas, 
beds, desks, and lamps for interior design. Thus, you can sketch a series of plans 
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FIG. 5-11 

and cost them simultaneously. You can also rearrange a plan, such as move 
furniture from room to room, without affecting the underlying data base. And, of 
course, the Macintosh Copy command lets you store and recall both the old and 
new versions of your drawings. 

EDUCATIONAL APPLICATIONS 

The teacher with a Macintosh in her home office or at school will find hundreds 
of educational applications for Filevision. With an hour's work at the computer, 
she can create maps of the region (point and click to display features of interest), 
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FIG. 5-12a 
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self-testing displays ("Can you identify each of the animals depicted here?"), 
anatomical charts, line drawings, and conic sections (Figure 5-13). The interac­
tive nature of the display makes the Macintosh the perfect teacher's aid. 

The Filevision Link command can be used to guide students through pro­
gressively more challenging material or to return them to a refresher course in 
the basics. Animation and blinking can be used to associate chord names with 
their positions on the piano keyboard (Figure 5-14). The dozen or more varieties 
of shading available (see the Shades menu) make it easy to label and identify 
geological strata. Hide and Unhide commands allow the same material to be 
used for both teaching and testing. It is even possible to strip an anatomical 
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model layer by layer by successively transferring higher layers to the back­
ground (see Edit menu). 

See Chapter 7 to learn more about Filevision's many and varied applica­
tions, including how to create drawings and symbols. 

FILEVISION'S LIMIT A TIO NS 

Every computer program has its limitations and Filevision is no exception. The 
trick is to turn these limitations into opportunities. 
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FIG. 5-13 

Some data-management applications don't lend themselves to a graphic 
representation, or there may be so many items in the data base that the screen 
becomes cluttered with symbols. This was the case with the data base that Telos 
Software, the developers of Filevision, set up to keep track of their own cus­
tomers. Their solution was twofold: First, they created new, smaller symbols 
using the symbol editor (see the Edit menu). Second, they did away with the map 
and replaced it with a grid using the "Show Grid" command on the Edit menu. 
They entered these new symbols within this grid and used the rows and col­
umns within the grid to represent two of the variables in their data base. 

Filevision is limited to 999 records per file, which may be too restrictive for 
many of your data-management applications. A file with only 999 records would 
certainly not hold the list of subscribers to my newsletter, "Laboratory Com-
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puter Letter." To overcome this limitation, switch to one of the many other 
popular file managers described in Appendix I. 

Warning: With a larger data base, a hard disk is necessary; the small disk 
used on the Macintosh internal disk drive can hold only 500to1500 records. One 
alternative is to subdivide your lists. In the case of our subscriber lists, we use a 
system of subdivision (suggested by the post office) based in part upon Zip Code 
and in part upon state. The results are satisfactory now that we have an external 
as well as an internal disk drive. 

Filevision can be somewhat frustrating for new users, particularly users 
like myself for whom freehand drawing is not second nature. Filevision has a 
large number of editing commands as well as a variety of different commands 
(depending on the situation) for erasing or undoing your work. Take the time to 
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learn how to use these commands during your initial experimental period. 
Their use can be a big timesaver. You won't need to start over if you make a 
mistake-Filevision's editing commands often provide an "easy" solution. Ex­
periment. Eventually, you'll find that your freehand drawings on the Macintosh 
are as professional as those of any commercial artist. 

WHICH FILE MANAGER SHOULD YOU USE? 

Some of Filevision's limitations can be overcome only by switching to another 
file manager. For example, Filevision does not verify the data before they are 
entered into the form, so you cannot ensure that all five digits of the Zip Code 
will be entered or that the sample weights recorded by your technician lie 
between 100 and 500 grams. Without these checks and verifications, you may 
not be able to turn over the task of data entry to less-skilled members of your 
staff. 

Although Filevision provides you with a running count of the number of 
objects of a given type (a must for inventory purposes), it will not sum over the 
group to provide you with a dollar volume for each component in inventory or a 
total sales figure for each item and salesperson in an order-entry data base. 
1stBase, DB Master, and Overvue (see Appendix I) do have this capability. 

Filevision does notJend itself to order entry because you cannot subtotal, 
compute tax and shipping, and total while at the keyboard. You can with DB 
Master, however. 

If you have one of the applications described above, see Appendix I to help 
select the software that is best for your needs. 
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------------------------------------------------

Preparing a Mass 
Mailing 
6 

In this chapter, you learn how to increase your profits through mass (but person­
alized) mailings. Form letters and mass mailings can be used to advertise specific 
products, to reply to inquiries, to remind patients of appointments, and to keep 
your image before the client with birthday greetings and new product an­
nouncements. 

The combination of Mac Write and MegaMerge allows you to create form 
letters, print mailing labels, address envelopes, and more. MegaMerge gives you 
the ability to take words, sentences, paragraphs, tables, and even pictures from 
one document and merge them into specific spots in several other documents. 
Include some last-minute art work on the form letter that accompanies your 
catalog-you don't have to wait to have special letterhead printed. 

MegaMerge allows you to write one letter and then quickly personalize it 
for a series of recipients, with name, address, salutation, the product(s) they 
inquired about, and a personalized postscript. Several examples appear in Fig­
ure 6-1. You'll save time because the address you've typed for the inside address 
on the letter will be reprinted automatically on a mailing label. 

Mail merging is done by typing special markers into the form letter where 
the personalized information is supposed to go (see Figure 6-2). In this chapter, 
you learn how to prepare a form letter and an insert list, how to generate a series 
of form letters, and how to produce the mailing labels that accompany them. 
You receive practical tips for creating effective form letters and learn how to use 
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FIG. 6-1 
Dear Salut: 

Just a reminder to all our favored customers that we are now stocking the new, 
improved model RJB3 manufactured by Harbor Associates. Like all models in 
the Harbor line, the RJB3 offers . . . 

Dear Guest: 

Well, like it or not, John is going to have a fiftieth birthday and we'd like you and 
Spouse to join us on August 18th for a get-together at our . . . 

Dear Inquirer: 

We're sorry for the delay in shipping our latest report, ''The Micro-Mainframe 
Connection.'' It was stop press waiting for some new developments from DCA 
and IBM. Now the report is at the printers, and we can promise you Inquirer 
that a copy will be in your hands no later than the first of the month. 

Dear Salut: 

House Bill 77865R4 is a matter of concern to all Americans, but it's of vital 
importance to those of us who are Party. Your good friend Refer has told us of 
your concern in this matter and we urge you to join Her with a contribution 
of .. . 

Dear Customer: 

Just a little note to accompany our '85/' 86 catalog. Say, didn't you like the Gift 
you received with your last order. We've had many raves about it. It's featured. 
in this year's catalog on page XX. Don't forget, if you get the spoons on page 
16, you get $1 off each other item you order at the same time. That's right. You 
get ... 
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MegaMerge's advanced features to cut the time of preparation. You also learn 
how to chain reports, overcoming the Mac's memory limitations to produce long 
documents from a series of short sections. 

There are three steps in producing a mass mailing: 

1. Create and maintain a list of prospects/clients or other potential ad­
dressees 

2. Create the form letter 
3. Print letters and labels 

FIG. 6-2 

s File Edit Search Format Font Style 

F-0 
February 8, 1985 

name 
Bddrass 
Cit!. Slate Zip 

Dear Patient: 

K LETTER 

It's now been six months since your last checkup. I ·ve made a tentative 
appointment for you on Ilate at Time. Please call me at 383-2971 to 
confirm. Would you like us to make appointments for Children at the same 
time? 

Very truly yours, 

R. Hancock, D.D.S. 
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In what follows, you learn to perform each of these three steps on your 
Macintosh quickly and productively. 

BUILDING A LIST OF PROSPECTS 

As most of us who are in the mail-order business realize (and all of us who are 
successful at it) , the secret of success lies in a good mailing list. There are many 
ways to get started in mailorder; new ways to attract customers are invented 
every day, but the best customers are still repeat customers. It takes just a little 

FIG. 6-3 

CJ File Edit Search Format Font Style 

~0 K LIST 

nam•= 
Address= 
Citg= 
State= 
Zi]l= 
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I 
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FIG. 6-4 
a File Edit Search Format Font Style 
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namt= John Bludgett 
RddreSS=345 Goingmy Way 
Jltn=Old .Tuwn. 

l1l~~ 

I 
effort to get an old and satisfied customer to buy again. And the Macintosh can 
help you to make the sale quickly and effectively. 

Begin today using Mac Write or some other word processor to maintain a list 
of your customers and their preferences. The obvious starting point is with each 
customer's name and address. You may also want to include the date of the last 
order or appointment, the names of a client's children or spouse, or the amount 
of a "suggested" contribution. Take the time now to sketch one or two sample 
form letters. These will help you to determine what information you should 
collect. 

You must create and use a template, as shown in Figure 6-3. Type the names 
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of the items you plan to include in the form letter one below the other in a 
column. Use a text font that you don't normally use in your correspondence for 
the names of the items, say, Athens. The font you use for the item names must be 
different from the fonts you use in your text. Insert an equal sign (=) following 
each of the item names using another font, say, Chicago. When you have com­
pleted the set of item names, enter a backslash on the line following. 

After the template is complete, make several duplicates, one for each of 
your customers, using MacWrite's Cut and Paste commands. Then fill in all but 
the last template with customer information (see Figure 6-4). Always keep one 
blank template at the beginning or end of your list. 

FIG. 6-5 
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FIG. 6-6 

HELP •••• 

MegaMerge is a program that takes two documents prepared by 
Maclllrite, merges them together and prints them out. 

Select a formletter document using the "Letter" menu. 
Select a mailing list document using the "list" menu. 

Use the "Mergefont" menu to set the font used to type the 
merge commands. Remember, the font used to type commands 
in the "Letter" and "list" must match the Mergef ont. 

Use "Page Setup" and "Print Pages" just like Maclllrite to print 
on standard paper sizes. 

Use "Print Labels" to print on standard sized mailing labels 

Chain "Letters" together by underlining their names. OK 

USING MEGAFILER AND MEGAMERGE 

You may want to use a data-management program like Filevision or MegaFiler 
instead of a word processor to collect and collate the data you put in your 
customer files. A data-management program has at least two advantages over a 
word processor. It's easier to use, allowing you to turn the job of data entry over 
to less skilled and less motivated personnel. It can sort the lists for you-by Zip 
Code, for example-allowing you to take advantage of bulk mailing rates. 

MegaFiler is a data-management program designed specifically for use with 
MegaMerge. As with Filevision, described in Chapter 5, MegaFiler lets you build 
your own data-entry form. A Find command lets you select a particular record 
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or records from the file (see Figure 6-5) . You may sort the records (by Zip Code or 
last name) and then print them to a list file for use by MegaMerge. 

(Hint: If you use MegaFiler to maintain your lists, always sort the records 
before you search through them with the Find command. Sorting can speed up 
the selection process ten times or more, depending on the size of the list.) 

CREA TING A FORM LETTER 

You can use MacWrite or any other word-processing program to create a form 
letter. The only requirement is that all the merge fields (Name, Address, Saluta­
tion) be written in a different font from the text itself, as in Figure 6-2. 

FIG. 6-7 
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ti MegnMerge f:uH Letter List 
Letter = K LETTER 

February B, 1935 

name 
Sil.dress 
Cit'g, Slate ZiJI 

Dear Patient: ~ 

It's now been six months since yom 
appointment for you on Dale at Tia: 
confirm. Would you like us to mak' 
time? 

Very truly yours, 

R. Hancock, D.D.S. 

FIG. 6-8 

List = K LIST 

name= Ethel Smith 
Rd.dress= 12 3 Old Mill Road 
Cit1=0ld Town 
State=OH 
Zip= 37893 
Palienl=Mrs. Smith 
Dale=Tuesday, Oct 11 
Time= 3:00 PM 
Childnm=Barbara, Georgette, and Doi 
\ 
name= john Bludgett 
Bil.dress= 345 Goingmy way 
Cit1=0ld Town 
State=OH 
Zip=37B93 

Whole books have been written about the preparation of form letters. My 
own view is that if you are writing a letter that will go to 5000 people (and bring 
in 40 to 80 sales) you should spend ten times as much time in its preparation as 
you would spend on an ordinary letter. Fortunately, since you are using your 
Macintosh to prepare the letter, most of the effort is mental. It will take you only 
seconds to revise the letter, but it may take you several minutes or hours to 
decide on the revisions. 

Hint: It's a good idea to have several people read over your letters before you 
mail them out. Don't rush a mailing. The time you spend on a form letter can be 
as important to you dollarwise as the time you spend on the product or service 
itself. 
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MERGING AND PRINTING A FORM LETTER 

Once you've prepared a mailing list and a form letter, merging the two and 
printing the letter are virtually automatic. The three-step process is no more 
difficult than pressing three buttons in sequence. After enteringthe MegaMerge 
program, you have four menus to choose from: MegaMerge, Letter, List, and 
Mergefont (Figure 6-6). Select the "Open" option from the Letter menu, then 
select the name of your form letter from the file directory by double-clicking 
(Figure 6-7). Select the "Open" option in the List menu, and when the document 
selection box comes to the screen, select the desired list (see Figure 6-8). Last, 
pull down the MegaMerge menu and select "Print Pages." Note: Be sure to select 
the Cut Sheet option from the Print display (Figure 6-9) if you are using letter­
head for your form letters. The result will look like Figure 6-10. 

PRINTING MAILING LABELS 

You may already have created a label form with MacWrite. If not, a form called 
"Label Letter" is supplied on the MegaMerge disk for use with MacWrite. (If 
"Label Letter" doesn't quite meet your needs, it can be easily modified with 
MacWrite or some other word processor.) You print the labels with the same 
three-step process you used to print the form letters. First, select "Open" from 
the Letter menu; but this time, open "Label Letter." Open the mailing list you 
used for the form letters. Finally, choose "Print Labels" from the MegaMerge 
menu. 

MegaMerge's dialog box (Figure 6-11) offers you a choice of two standard 
label sizes and either one or two across. Generally, you will use 3112 by 15/15 inch 
labels for display envelopes and 4by17/15 inch labels otherwise. For example, we 
often use a check-off reply card in our mailings with an option for "bill me" or 
"check enclosed." To save time for the recipient (and make it as easy as possible 
for him or her to say "yes, bill me"), we attach a 15/15 inch mailing label with his 
name and address to this card. To save time for ourselves in addressing the 
envelopes, we place the card at the front of the mailing where the address will be 
visible through the window envelope. With luck, the mailing label will see 
double-duty- going to the prospect and, we hope, returning with his order. 

"PERSONALIZED" FORM LETTERS 

Up to now, the form-letter insertions have been rather simple ones, like names, 
Zip Codes, and dates. But there is nothing to prevent you from inserting entire 
paragraphs or reports. For example, suppose you want to use a form letter to let 
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FIG. 6-9 

• mrm · m• l:~Ht Letter List Merge font 
Letter = K LETTER 1 List = K LIST 

~ .... ....D.. ....... - ::I .... 

Quality: QHigh @Standard 0 Draft ( OK ~J 
Poge Bonge: @ Hll 0 From: D To: D 
Copies: D 
Poper Feed: 0 Continuous @Cut Sheet (Cancel ) 

Dear -YalleDl: Palial=Mrs. Smith 

It's now been six months since you 
Dale=Tuesday, Oct 11 
Time=3:00 PM 

appointment for you on Dale at Tia: Children=Barbara, Georgette, and Doi 
confirm. Would you like us to makE \ 
time? 

name= John Bludgett 

Very truly yours, Bddress= 345 Goingmy Way 
CitV=Old Town 
5tale=OH 

R. Hancock, D.D.S. Zip=37893 
'2l 

February 8, 1985 

Ethel Smith FIG. 6-10 
12 3 Old Mill Road 
Old Town,OH 37893 

Dear Mrs. Smith: 

It's now been six months since your last checkup. I've made a tentative 
appointment for you on Tuesday, Oct 11 at 3:00 PM. Please call me at 
383-2971 t:o confirm. Would you like us t:o make appointments for 
Barbara, Georgette, and Donna at the same time? 

Very truly yours, 

R. Hancock, DD.S. 



FIG. 6-11 
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Dame= John Bludgett 
Bddress= 345 Goingmy Way 
Citg=Old Town 
State=OH 
ZiJ1=37893 

your district representatives know about recent changes in sales policies. A 
simple form letter won't do, for over and above those changes that affect all 
representatives, there are several changes that are unique to each region. 

You would solve the problem in two stages. First, revise the form letter to 
the district representatives so that the concluding paragraphs look something 
like this: 

... how much I appreciate your cooperation with these changes. 

Personal 

Very truly yours, 

~ 
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And then we revise the mailing list to look like this: 

Name= Mac Jones 
Address= 2333 First Avenue 
Address2= Los Angeles CA 91 001 
Salutation= Mac 
Personal= 

Region 21 has always been at the top in productivity. With the changes 
described above and your own plan to increase discounts to 150/o on bulk pur­
chases made before March 1, I expect we will see you at the top once more. 
Good work. 

MegaMerge Lm Letter list Mergefont 
§0 Letter = Report.mass 

Sum.mat¥ 
first 0Ull[tet 
8ecmui 0Ull[ta 
Th.Ltd Ouartet 
fowth Ouart&t 
Ci:mph.Om 
Ci:mph. Two 
Tuble 
Drawing: New Store Room 
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FIG. 6-13 
s MegaMerge hm Letter List Mergef ont 

§0 Letter = Chiltonflgreement--Mass 
Chilton Book Company Author-Publisher Agreement 

Publication Agreement made the ._tt between Chilton Book Company 
of Radnor PA USA, hereinafter called "Publisher" and 

Whereas, !lt)&Uft l t!fl]¢ 
Now, filaUM JI 
~.Jauts t-»U 

Pub 1 i sher shall pay to the author as an advance against royalties, the 
sum of !billltttt payable as follows flt.St on signing of this agreement 
and ittimb on delivery of the manuscript. Such advance shell be 
non-returnable except as otherwise provided for in th1s aQreement. 

CHAINING REPORTS 

MegaMerge can also be used to combine several small documents into a single 
long report and to build contracts and contractual letters out of "canned" mate­
rial or boilerplate. 

We all know how much time it can take to load and unload documents off 
disk. To save time with long reports, it's good practice to break them up into 
sections and edit one section at a time. You don't need to spend time reassem­
bling them because, with MegaMerge's help, you can print them as one single 
document even though they are stored separately. 
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To chain several sections together and print them in a single step, simply 
type a series of chaining commands into the first or master document. For 
example, Figure 6-12 is the master document for an annual report. 

The names of all documents to be chained are typed in the font used for 
merging and then underlined. Note that you may chain spreadsheet tables, 
graphs, and pictures as well as text material. 

As a second concrete example of the chaining approach, below is a copy of 
Chilton Book Company's author-publisher agreement (Figure 6-13). Note that 
both mailmerge commands (like Author and Title) and chaining commands (like 
Standard Clause i-vii) are present. Both types of commands are in Mergefont; 
the distinction is that the chaining commands are underlined. 

Good luck applying mailmerge productively in your business too. 
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======================== 

Track and Control 
Your Inventory 
7 

In this chapter, you learn how to use Filevision and your Macintosh to prepare 
and maintain an inventory of parts and supplies. A mail-order house can use 
Filevision to track its stock by item, box, and bin, as can a parts supply house or a 
hardware store. An automobile dealer can track the location of every car on the 
lot and the equipment and accessories that come with each car. Ditto for a 
retailer or wholesaler of white goods-washing machines, radios, tractors, or 
small appliances. 

And there are many less traditional applications. A coach can track his 
players' abilities and performance by their location on the field. A farmer can 
keep track of his dairy cattle and their milk production, stall by stall. Even if you 
have no immediate business application, you can use what you learn in this 
chapter to record the content of those mysterious boxes you have piled in your 
garage and up in the attic. Are you a book collector? records? tapes? stamps? 
Keep track of your collection item by item, album by album. 

As the preceding examples reveal, an inventory is really only a simple 
extension of a data base, something you learned how to create and update in 
Chapter 4. The only distinction-and it is a small one-is that the inventory 
often has more levels or data types. For example, a parts supply house may keep 
track of its stock by room, rack, shelf, and item. A hardware store will have 
display areas, drawers and shelves, and items. An automobile dealer has lots and 
showrooms, automobiles, and an extensive two-page description associated 
with each automobile. 
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What about your own inventory? Stop now and try to conceptualize your 
data base. Do you keep your stock in more than one location? In several small 
buildings? In a garage? In what used to be a den or a family room? Are the items 
stored in boxes or bins within each room? Do you have several distinguishable 
items in each box, or a large but varying number of a single item? Do you need a 
lengthy description of each item, or do you just need to know the number of 
items? 

You will probably require a data form for each item if only to keep track of 
its name (1" X 114" screw), its price (3 cents), and its cost (1 cent). 

BUILDING AN INVENTORY 

In this chapter, we consider the inventory problems of a medium-sized automo­
bile dealer, one who sells parts as well as cars. This dealer has a large collection 
of new and used cars divided among a showroom and an upper and lower lot. He 
wants his salespersons to be able to guide customers quickly to those cars with 
the equipment and accessories the customer wants. 

A two-screen data-entry form is associated with each automobile. The first 
screen (shown in Figure 7-1) contains basic information about each automobile 
similar or identical to that which appears on the window sticker-list price, 
model number, engine capacity, a blank field for options, and so forth. This 
display may be shown to the customer to whet his or her appetite before making 
the trek out to the lot. The second page, which the customer ordinarily doesn't 
see, contains additional information, such as dealer cost, that is helpful to the 
sales staff in adjusting the quoted price upward and downward depending on 
the customer's reaction. 

A similar data structure would be used by any retailer or wholesaler who 
deals in large appliances. 

Building the data base is a straightforward four-step process. First, after 
turning on his Macintosh and loading Filevision as in Chapter 4, the dealer 
draws a sketch of his lot, noting the three separate display areas. Accuracy is not 
essential, although it is advisable to draw each display area to scale in order to 
maintain its shape and general proportions. (A different scale may be used for 
each area.) Your drawing must be original; you cannot use the Clipboard or 
Scrapbook to copy images from other Macintosh programs. 

You can use any of the drawing tools on the left of the Filevision screen to 
sketch in the background (see Figure 7-2). To save time, experiment with each of 
the drawing tools for a few minutes before you begin. If you want to duplicate 
parts of the background- sketching a second showroom, for example-you 
can simplify the copying process by drawing multi part objects that can be dupli­
cated as a unit. 
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~ Four Inventory-Building Steps 

1. Conceptualize (rooms, drawers, and items) 

2. Draw a picture 

3. Locate typical objects 

4. Create data-entry forms 

FIG. 7-1 
'( ' .. .. . •: 
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FIG. 7-2 
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To draw an object like a building that consists of several parts, hold down 
the shift key before you draw each part. For example, if you want to duplicate a 
series of buildings, follow this three-step process: 

1. Draw the original 
a. Draw one side of the building. 
b. Hold down the shift key and choose a drawing tool from the toolbox 

for the next element of the drawing. 
c. Release the shift key. 
d. Draw the next element, the roof, say, or the doorway. 
Repeat steps b, c, and d until the building is complete. 
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2. Make a copy 
a. Click the building you've just created to select it. 
b. Choose "Bind" from the Edit menu (to bind all the elements together 

for the move). 
c. Move the pointer to the diamond-shaped center handle. 
d. Press the mouse button and drag the copy to its new location. 

3. Modify the building 
By pulling on the side handles you can stretch, compress, or deform an 
object. You can even give your drawings a three-dimensional perspec­
tive. 

FIG. 7-3 
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MAKING COPIBS OF AN IMAGE 

You will want to make multiple copies of an image for most of your drawings. In 
this instance, the dealer wants to make multiple copies of a sedan, a sports car, a 
van, a convertible, and a truck. 

You could make the original drawing with one of the tools at the side of the 
Filevision display. But I recommend that you use the symbol editor instead so as 
to reduce the amount of memory required to store each image. When you draw 
an object, it takes several hundred bytes of storage to store each of the copies. 
When you use the symbol generator, only the original takes up significant space. 
Each of the copies requires only two bytes of storage (for its horizontal and 
vertical screen coordinates). 

Once you've created the original with the Symbol Editor (see Figure 7-3), 
copying it is a three-step process. First, pull down the Symbol Editor menu at the 
top of the screen and select the image of the convertible, as shown in Figure 7-4. 
The image will be transferred to the tool bar. Now point to and click the image on 
the tool bar. Last, move your cursor to each point on the drawing where you 
wish to locate a copy of the symbol and click. 

BUILDING THE DATA BASE 

Building the data base is a two-stage procedure. First you create the form, then 
you or an employee completes a copy of the form for each item in inventory. 

Data entry can be an expensive, time-consuming process, particularly 
when you must hurry to catch up on the several hundred or more items you 
already have in stock. You can help to keep data-entry costs under control by 
taking the time to make a well designed form. The form should be self-guiding. 
Avoid abbreviations. Try to copy a form that your employees are used to com­
pleting. In Figure 7-1, the automobile dealer has modeled his data-entry form 
after the window sticker. 

Only the first page of this form is visible in the figure. By clicking the arrow 
in the lower right-hand corner of the screen, you can scroll down the display to 
reveal such other hidden items as preparation and delivery charges and original 
dealer costs. These are details that the dealer will use in his negotiations. In 
other applications, such as personnel or equipment maintenance, the second 
screen might be reserved for a record of performance. 

THE PARTS DEPARTMENT 

The same four steps in building an inventory-conceptualize, sketch the stor­
age areas, locate symbols, and record data-might be used to create and main-
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tain an inventory for the dealer's parts department. Again, the key to keeping 
data-entry costs under control lies in the conceptualization. 

For example, the dealer has many parts that are purchased by the dozen but 
sold individually (such as oil filters) . He may choose to represent each box or 
dozen as a single symbol on the screen and to use the data-entry form to record 
the number of items remaining in the box. Later, he can use Filevision's "High­
light" feature (on the pull-down Tinker menu) to highlight all empty boxes or all 
boxes that have dropped below the reorder quantity. (Figure 7-5 is an example of 
a salesperson using the Highlight feature to help locate a recent-model automo­
bile for a customer.) 
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On the other hand, the parts manager may want to group all voltage regula­
tors on one shelf so that he can use a simple two-stage process to retrieve the one 
he needs: first scanning the shelves until he finds the one holding the voltage 
regulators, then examining each regulator individually until he finds the model 
number he is searching for. 

Note that the preceding paragraph is deliberately ambiguous. The parts 
man could be walking among the racks and shelves in the parts room or scanning 
the inventory on the Macintosh display. The operations are similar. The only 
real difference is in the time saved at the counter by scanning the display before 
walking back into the parts room. 
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RACKS, SHELVES, BOXES, AND ITEMS 

How you group items will determine how rapidly you can retrieve and update 
your inventory. Begin with an inventory of only a few select items, enough to 
give you a feel for how your computerized inventory should be organized. Go 
through the four steps described above for your mini-inventory, then try to use 
the inventory you've created. Expand slowly. Don't launch a total conversion to 
a computerized system until you're certain your groupings are appropriate. 

If members of your staff will be entering the data, try a trial run with one of 
your employees. Choose someone "average," rather than someone who is su­
perintelligent or poorly motivated. You may find that you have to go back and 
modify the forms you've created. Take the time. It is difficult, if not impossible, 
to modify a system once you are committed. The time you spend in careful 
preparation initially will pay off in greater turnover and reduced inventory 
levels. 
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======================== 

The Next Steps: 
Increasing 
Productivity 
8 

You've come a long way since you first began to computerize your business 
operations. You've learned to use a spreadsheet for sales analysis, checkbook 
reconciliation, manpower allocation, financial planning, and engineering cal­
culations. You've produced charts and graphs to illustrate your sales projections 
and accompany your reports. You've learned to use the Macintosh to simplify 
and organize your correspondence so that you can do much ofit yourself with­
out secretarial assistance. And you've learned how to use the Macintosh Clip­
board to combine text, tables, and graphs in a single report. 

You discovered dozens of applications for a computerized file manager, 
from a simple desk-top Rolodex to a complex data-management system for 
inventory control. And you learned how easy it is to combine word processing 
and computerized data management to make your mail-order operations more 
productive. 

Still, as your business grows, you may outgrow the capabilities of the com­
puter software you've reviewed here. For example, the electronic checkbook 
you built with your spreadsheet won't replace a true accounting system when it 
comes time to persuade potential investors of your business' worth. As others 
join your practice and the number of clients and projects grows, you may re­
quire a more formal way of scheduling activities than the simple manpower-al­
location scheme. An appointment-scheduling program or a project scheduler 
may prove to be an absolute necessity. 
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You will find dozens of applications for communications software, from 
accessing an on-line data base to get the latest up-to-date information to building 
an electronic mail network to link your chain of growing businesses. Last but not 
least, you may find that you have to develop your own applications software. In 
this chapter, you learn how to get and how to apply the programs you need for a 
growing business. 

ACCOUNTING SOFTWARE 

Are you making money? Which of your enterprises are most profitable? (That is, 
which are giving you a maximum return on the least expenditure of your time 
and capital?) Are your bills getting out on time? Do you have to borrow money to 
cover delinquent accounts? Do you know which of your customers are paying 
and which aren't? Are you paying your bills on time? Do you know which bills 
you should pay first? Will the bank give you a loan when you need it? How long 
does it take you to get your accounts in shape to go to the bank? Are you paying 
too much in taxes? How long will it take you to get your accounts in shape for 
your tax consultant? 

If you can't answer these questions, or if the answers aren't satisfactory, a 
computerized accounting system should be your next software purchase. 

You need accurate, up-to-date accounts to ensure that your business is truly 
profitable. Chapter 2 described how to use a spreadsheet to maintain a journal of 
expenses in order to track costs and reconcile your checkbooks. (It's particularly 
helpful at tax time.) Still, the spreadsheet journal is only a first step toward a true 
accounting system. Your checkbooks are under control, but you still don't know 
which parts of your business are really profitable? And will your reports per­
suade a banker or other potential lender or investor? 

The spreadsheet journal (or journals) constitutes a "single-entry" book­
keeping system. You track expenditures and income, but you don't know how 
the one relates to the other. (If it's hard for you to follow, it will be impossible for 
potential investors.) 

You need an integrated computerized accounting system that will tie all 
your accounting data together. One good example is Back to Basics for the 
Macintosh. 

Back to Basics is a labor-saving tool for preparing financial statements. Your 
banker, other potential lenders and investors, your CPA, and your tax adviser 
will accept the reports this double-entry accounting system produces. You and 
your co-investors and partners will use it to identify the principal sources of 
profit and loss. You'll use it as a planning tool, setting objectives and measuring 
performance with the figures they provide. 
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computerized accounting system, see my book Computerize Your Business 
(Chilton Book Company, 1984). 

SCHEDULING SOFTWARE 

There are two principal types of scheduling software-appointment schedulers 
and project schedulers. An appointment scheduler like Front Desk for the 
Macintosh is particularly valuable for consulting engineers, dentists, doctors, 
CP As, attorneys, and others who wish to schedule and monitor the activities of 
all their associates. Front Desk allows you to zoom from one person's calendar to 
the next, to zip from a monthly view to a weekly view to a day, and to look at a 
composite view of your entire operation. (The last is a must when different 
practitioners use a common set of resources, like examining rooms or meeting 
rooms.) 

Use your appointment scheduler to generate reports to measure and im­
prove your productivity. How many hours did each individual in your office 
spend on revenue-producing activities last month? How many dollars did each 
individual bring in? What service and which resources generated the greatest 
amount of revenue? What profits are projected for future months? 

Project schedulers (MacProject is a good example) are a boon to construc­
tion firms, engineers, and others who need to schedule the joint activities of 
several people who will be working on several projects simultaneously, say, a 
lead engineer, a senior engineer, and two junior draftsman. A project scheduler 
can cut project costs, reduce overhead, and put an end to the "hurry up and 
wait" syndrome that plagues too many once-growing businesses. 

After each project has been broken down conceptually into a set of small 
interrelated tasks, computerized scheduling algorithms define a critical path. 
MacProject's display reveals the critical tasks along with their equally critical 
starting and completion dates. The manager is now able to swap personnel from 
one project to another and reschedule noncritical tasks without diminishing 
performance quality. 

Many noncomputerized scheduling algorithms claim to produce the same 
salutary result. But the big advantage of the computerized method is that it is so 
easy to update and modify a schedule whenever the requirements change. (And, 
never fail, those requirements will change, usually on the day you first work out 
the schedule.) 

If you're already using a computer time-sharing service to help you sched­
ule construction, you'll find having your own scheduling software a big cost­
saver. And because your own computer is so convenient to use, you'll use the 
scheduler more often, with greater savings as a result. 
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COMMUNICATIONS SOFTWARE 

One of the fastest ways to increase your productivity is with communications 
software. You'll be able to use your computer as a window to the world, gather­
ing the lastest stock-market quotations from an on-line time-sharing service, 
exchanging programs and reports with colleagues, even communicating with 
the corporate mainframe. 

There are five basic ways in which a Macintosh equipped with communica­
tions software can give you increased value: (1) as a terminal to a time-sharing 
service, (2) providing point-to-point communications between you and another 
computer user, (3) electronic mail (this means unattended reception and trans­
mission at off-hour rates-pictures and graphs too), and (4) distributed data 
processing, which means sharing the workload among micros or among micros 
and mainframes. 

IMMEDIATE ACCESS TO INFORMATION 

Accountants, attorneys, engineers, physicians, scientists, stockbrokers, techni­
cal librarians, and other professionals use their computers to get immediate, 
up-to-date information from the world's most comprehensive data sources. 
They plug in their Macintosh to the telephone, dial the phone number of one of 
the more than 500 on-line data services, and, presto, they have the information 
they need. Telephone access to an on-line data bank gives the professional a 
competitive edge. 

Some farmers use time-sharing services to get price quotations from mar­
kets thousands of miles away. These farmers are no longer dependent on local 
buyers. If the price is better in Corpus Christi, they ship their product to the Gulf. 
Their time-sharing service means bigger profits for them and lower prices for all 
consumers. 

Among the most popular time-sharing services with Macintosh users are 
Agridata, Compuserve, Dialog, Dow Jones, and The Source. Compuserve and 
The Source also offer the advantage of electronic mail. The pharmaceutical firm 
Merck, Sharp, and Dahme rents a "mailbox" from The Source. Its staff in the 
field can communicate with the home office via the mailbox at a time and from a 
location of their own convenience. No more telephone tag between the East and 
West Coasts. No more lost briefings. 

A manufacturer's representative uses an electronic mailbox as his office. 
He takes his Macintosh with him when he goes out on sales calls and phones in 
each evening to The Source with the day's orders and expenses. When he 
returns home, he plugs in the Macintosh to the phone again, "empties" his 
mailbox, and has his orders out the same day. 
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Consult Appendix I for capsule reviews of Macintosh communications soft­
ware~ For more advice on practical applications, see my book Increasing Your 
Productivity Through Computer Communication and Networking (Chilton Book 
Company, 1985). 

Note: You also will need a telephone modem to modulate and demodulate 
the computer's signal so that it can be sent out over a telephone. The cost varies 
from $80 to $500. Recommended: A 1200-baud/300-baud Hayes command­
compatible modem that supports autodial/autoanswer. 

DEVELOPING YOUR OWN SOFTWARE 

The best word of advice about developing your own application software is 
"Don't." 

It is not cheaper to write your own programs. Development costs can be 
astronomical. With commercial software, development costs are spread over 
many users. 

Commercial software has three further advantages: First, most of the errors 
in the programs have been found and corrected, and your work won't be subject 
to recurring delays. Second, updates to reflect changes in the applicable laws or 
improvements in the program are usually available for a nominal charge. Third, 
buying your software allows you to preserve your flexibility. You can buy the 
services of many different kinds of experts without becoming an expert your­
self. 

If you still insist on doing some of your own programming, then you will 
need to purchase and use a programming language. There are many different 
languages and dialects for the Macintosh, each with its own advantages and 
liabilities. It you are a non programming professional, use a language with which 
you are already familiar. 

The newcomer to programming has six principal choices: Basic, Cobol, 
Fortran, Forth, Pascal, and C. Basic is an easy language to learn. There are many 
books of Basic programs on the market from which you can copy routines and 
entire programs. Microsoft's Macintosh Basic is particularly good for the begin­
ner because you can view each step of the programming process as you edit and 
debug your programs. 

Cobol was one of the first computer languages (Rear Admiral Grace Hopper 
was instrumental in its development), and it is still an important mainframe 
business language, but it is not an easy language to learn. Pass it by. 

Like Cobol, Fortran is a classic programming language. Unless you are a 
classicist, pass it by in favor of Pascal and C. 

Forth is extremely easy to learn. And it is extremely powerful in the sense 
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that one command can do the work of a hundred in some other language. It has a 
small but devoted following, particularly among the manufacturers of test 
equipment and laboratory instrumentation. Its chief drawback: There just 
aren't enough published program listings you can use as models for your own 
programs. 

Pascal offers many advantages to professional software developers who 
work in teams. It is extremely structured, and this structure helps keep the team 
together. Unfortunately, this same insistence on structure can drive the begin­
ner nuts. 

Today, most software developers are switching to C. The reason is the ease 
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with which you can transfer your programs from one model of computer to 
another. You can develop a program on the Macintosh today and have it up and 
running on the IBM PC tomorrow. A good way to get started programming in C, 
quickly and profitably, is to read Writing Business Programs in C Language by 
M. Franz and P. Good (Chilton Book Company, 1985). A good book for everyone 
who wants to program, regardless of the language, is Problem-Solving Principles 
for Programmers, by William E. Lewis (Hayden Book Company, 1980). 

OTHER SPECIAL APPLICATIONS 

Don't overlook the Macintosh's value in other specialized applications. For 
example, the Macintosh is of particular value to the designer, the graphic artist, 
and the engineer because it provides all the freedom of a sketch pad with all the 
convenience of a computer. 

The Macintosh is the convenient way to lay out a new facility, an irrigation 
system, an orchard, or a garden plot. The results are smudge-free, and there is 
never a sign of an erasure. Designs are easily updated. While it could take from a 
half-hour to an afternoon to create an original design, changes made with com­
puter-aided design take a matter of moments. And repeated elements are easily 
replicated. Sketch a chair, then replicate it to fill an auditorium. The Macintosh 
is a major timesaver. 

You can create your own designs from scratch with MacPaint, but you'll 
save time by purchasing sets of predrawn templates for specific applications. 
Figure 8-1 shows one of a dozen such sets of designs available in Da Vinci Inte­
riors, a product of Hayden Software. 

The scientist can use the Macintosh for both data acquisition and data 
analysis. Figure 8-2 depicts a line-plot of sample data gathered with the Taurus 
One/05 data acquisition and control peripheral. The data were acquired with 
the aid of Macquisition and Multiplan software. The Chart program (reviewed 
in Chapter 3) was used to produce the actual plot. 
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SPREADSHEETS 

Jazz 
Lotus Development Corp. 
161 First St. 
Cambridge MA 02142 
617 /492-7870 

Multiplan 
Microsoft Corporation 
10700 Northup Way 
Bellevue WA 98009 
800/828-8088 

Overvue 
Provue Development Corpora­
tion 
222 22nd Street 
Huntingdon Beach CA 92648 
714/969-2431 
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Software for All 
Your Business 
Needs 
Appendix I 

Requires 512K memory. Five functions 
in one: spreadsheet superior to Multi­
plan; graphics inferior to Chart; text ed­
itor comparable to MacWrite. Design 
your own forms to speed data entry. 
Communications a must for investors. 

A must program for almost any business 
application. Advantages include flexi­
ble formats, simplified data entry, time­
saving defaults, iteration of circular ref­
erences, named sections, sort function 
for data management. 

A file manager that functions like a 
spreadsheet. (Or is it vice versa?) Fields 
correspond to columns. Restrict data 
entry to letters only, numbers only, or 
even yes/no. Calculated fields. Tem­
plate format is used for reports. 

155 



Quartet 
Haba Systems 
15154 Stagg St. 
Van Nuys CA 91405 
818/901-8828 

TK!Solver 
Software Arts 
27 Mica Lane 
Wellesley MA 02181 
617 /237-4000 

GRAPHICS 

Chart 
Microsoft Corporation 
10700 Northup Way 
Bellevue WA 98009 
800/828-8088 

MacPaint 
Apple Computer Inc. 
20525 Mariani A venue 
Cupertino CA 95014 
800/538-9696 

Ila Vinci Interiors 
Hayden Software 
600 Suffolk Street 
Lowell MA 01853 
800/343-1218 

WORD PROCESSING 

Mac Type 
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Palantir Software 
7701 Wilshire Place 
Houston TX 77040 
800/368-3797 

Four functions in one: all of Multi­
plan's spreadsheet features, including 
sort function for data management. 
Wordwrap simplifies entry of multiple 
lines of text. Graphs include pie charts, 
line graphs, and bar charts. 

Makes solving complex problems no 
more difficult than copying formulas 
out of a book. Solve simultaneous equa­
tions in explicit or implicit form. Units 
table simplifies engineering calcula­
tions. You may need help getting 
started. 

Twenty-two types of graphs, including 
area charts, bar and column graphs, line 
graphs, pie charts, and scatter plots. 
Tremendous flexibility over style, text 
sizes, and positioning, yet amazingly 
easy to use. 

A designer's toolbox, a painter's palette. 
Use to create letterhead and enhance 
your charts and graphs. Copying facility 
simplifies modular design. Stretch or 
shrink designs with ease. Edit in-the­
large or pixel by pixel. 

For architects, retailers, and anyone re­
sponsible for laying out a store interior 
or a set of offices. More than a hundred 
predrawn images are included in this 
useful addition to MacPaint. 

Touch-typing tutorial program. Drills 
are geared, automatically, to specific 
problems. Train on standard or high­
speed Dvorak keyboard. 
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Mac Write 
Apple Computer Inc. 
20525 Mariani Avenue 
Cupertino CA 95014 
800/538-9696 

Word 
Microsoft Corporation 
10700 Northup Way 
Bellevue WA 98009 
800/828-8088 

FILE MANAGERS 

Filevision 
Telos Software Products 
3420 Ocean Park Boulevard 
Santa Monica CA 90405 
213/450-2424 

DB Master 
Stoneware Inc. 
50 Belvedere 
San Rafael CA 94901 
415/454-6500 

MegaMerge 
Megahaus Corporation 
5703 Oberlin Drive 
San Diego CA 92121 
800/358-8882 

tstBase 
Desktop Software Corporation 
228 Alexander Street 
Princeton NJ 08540 
609/924-7111 
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Easy-to-use word processor lets you 
combine tables and graphics with text. 
Limited control over output. Supports 
only one model of printer. Can't pro­
duce mailing labels. Can't display or in­
sert second file. 

Upgrade from MacWrite to Word when 
you need greater control over the for­
mat of your reports. Output can be di­
rected to a modem or to one of a variety 
of letter-quality or dot-matrix printers. 
Bonuses: mail-merge, footnotes, glos­
saries. 

Manage pictures and symbols as easily 
as text. Map sales territory, maintain in­
ventory. Animation is an unexpected 
bonus. Won't compute totals or subto­
tals. Won't check data as they are en­
tered. 

Sophisticated file manager. Good for 
order entry; provides for computed 
fields. But data are not verified at time 
of entry. Wildcard search. Keyed stor­
age means fast retrieval. Generate mul­
tiple reports. 

A bare-bones file manager. No edit 
checks during data entry. No calculated 
fields. Limited selection and report for­
matting facilities. 

Easy-to-use file manager. Lacks checks 
and verifications. Will compute sum, 
average, min/max. Flexible report for­
mats, good for mailing labels. Easy to 
combine several files into one. 
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pfs: file & report 
Software Publishing 
1901 Landings Drive 
Mountain View CA 94043 
415/962-0191 

BUSINESS EXPANSION 

Back to Basics 
MSA Personal Computer Prod­
ucts 
3445 Peachtree Road 
Atlanta GA 30326 
800/554-8900 

Electric Checkbook 
State of the Art 
3191-C Airport Loop 
Costa Mesa CA 92626 
714/850-0111 

Front Desk 
Layered, Inc. 
85 Merrimac Street 
Boston MA 02114 
617 /423-9041 

COMMUNICATIONS PACKAGES 

Ha ha Com 
Haba Systems 
15154 Stagg Street 
Van Nuys CA 91405 
818/901-8828 

Straight Talk 
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Dow Jones 
P.O. Box 300 
Princeton NJ 08540 
800/257-5411 

Easy-to-use file manager. Lacks checks 
and verifications. Will compute counts 
and sums. Good for columnar reports. 
Has wildcard search. 

General Ledger accounting systems. 
Windowing and calculator simplify 
transaction entry and setting up chart of 
accounts. Toll-free end-user support for 
90 days. Excellent manual includes in­
troduction to double-entry accounting. 

First step toward computerized ac­
counting. Track expenses-assign 
checks to multiple accounts. Print your 
checks! Store info for bills you pay regu­
larly. Automatic reconciliation. 

Perfect for attorneys, doctors, accoun­
tants, architects, consultants, and 
others who need to schedule and bill for 
appointments. Schedule several staff 
members' calandars simultaneously. 
Zoom among daily, weekly, and 
monthly views. 

Autodial from stored telephone di­
rectory plus keystroke logon. Store 
communication protocols. Simplified 
transfer of files from computer to com­
puter (text files only). 

Communications package for linking 
with time-sharing services. Supports 
autodial. Store and reuse communica­
tion protocols. Rated fair for file 
transfer. Logan not automatic. 
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Mac Link 
Data Viz, Inc. 
P.O. Box 1319 
Norwalk CT 06856 
203/866-4944 

MacPhone 
Intermatrix 
554 Satsuma Avenue 
North Hollywood CA 91601 
818/509-5868 

MacTerminal 
Apple Computer Inc. 
20525 Mariani Avenue 
Cupertino CA 95014 
800/538-9696 

Software/cable combination lets you 
transfer data from an IBM PC to a Mac­
intosh. MacLink converts Lotus 1-2-3 
files to Multiplan, or Multimate files to 
Mac Write. 

A bare-bones file manager for tele­
phone numbers. Can dial a touch-tone 
phone provided with the package, but 
cannot be used with a modem. Timer 
lets you track and control phone 
charges. 

Bare-bones communication package 
designed to work with Apple modem. 
Supports autodial and autoanswer. Lets 
you store and reuse communication pa­
rameters. Will not logon automatically. 
Supports attended file transfer. 

Macquisition 
Small Business 
New England 

Data-acquisition software for use with 
Computers of Taurus Lab front-end control unit. Lets 

P.O. Box 397 
Amherst NH 03031 
603/673-0228 

WRITING YOUR OWN SOFTWARE 

Hippo-C 
Hippopotamus Software 
1250 Oakmead Parkway 
Sunnyvale CA 94086 
408/730-2601 

Microsoft Basic 
Microsoft Corporation 
10700 Northup Way 
Bellevue WA 98009 
800/828-8088 
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you control collection sequence, trigger 
times, gains, number of samples, and 
sampling rate. Results are passed to 
Multiplan template for analysis. 

Excellent for the beginner who wants to 
learn to program in C. Includes an edi­
tor, compiler, run-time interpreter, de­
bugger (with easy-to-understand error 
messages), library, and on-line tutorial. 
No support for floating point numbers. 

Partially compatible with IBM PC Basic. 
Supports most of Macintosh's advanced 
features, including high-resolution 
graphics. Windows simplify program 
editing and debugging. Program I/O 
can be directed to Clipboard for easy file 
exchange. 
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------------------------------------------------
Increasing the 
Macintosh's 
Capabilities 
Appendix II 

Your Macintosh can be equipped with 128,000 characters (128 Kb) to 512,000 
characters (512 Kb) of memory, and with one to four diskettes and hard disks. 
The standard configuration has 128 Kb of memory and one internal diskette that 
holds about 400,000 characters (400 Kb) of information. 

Information that won't fit in memory must be stored on disk. But disk 
functions proceed at a much slower speed. The more memory you have, the 
fewer delays you'll experience. And you will be able to use more sophisticated 
programs, like Jazz, that won't fit in the confines of 128 Kb. 

Each additional disk drive increases your ability to store and retrieve data. 
A hard disk drive not only holds more information than a diskette (5000 to 15000 
Kb), but it can load and unload its data almost ten times as fast as the internal 
diskette drive. 

You don't want to pay for more hardware than you need. On the other hand, 
unless you have all the hardware your business applications call for, you'll pay 
for the deficiencies with your time ten times over. Review your applications 
before you buy. 

FOR ALL APPLICATIONS 

Two disk drives are a minimum for all business applications. If you have only 
the single internal drive that comes with the standard Macintosh, you'll spend 
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far too much time swapping disks in and out. Make a second disk drive one of 
your first purchases. 

The exception that proves the rule is when you take your Macintosh on the 
road. On the road, weight and packing size are the overriding considerations. 
My CPA takes her Macintosh with her when she sees clients. She uses her 
computer to collect data and to make preliminary calculations. She says she can 
often eliminate as a result one or two trips back and forth from the client's office. 
She doesn't take any extra equipment with her-it would reduce the Macin­
tosh's portability-but back in her office she keeps a hard disk for rapid loading 
and unloading of the data she has collected. 

(Incidentally, if you're on the road a lot, a lightweight telephone modem for 
the Macintosh will allow you to communicate your results back to the office 
each day. A 300-baud/1200-baud autodial modem with Hayes-compatible 
command structure is recommended.) 

FOR SPREADSHEETS 

128 Kb of memory is adequate for most spreadsheet applications: It corresponds 
to almost 256 rows of 10 columns each. Larger models usually can be handled by 
linking several spreadsheets together (see your Multiplan manual). Some CPAs 
and corporate accountants may want to expand to 512 Kb to handle large multi­
divisional models. (Warning: If you do increase the amount of memory, a hard 
disk is a must.) 

A numeric keypad (available from Apple Inc.) will speed data entry. 

GRAPHICS 

It can take several minutes to load a chart or a design on or off a disk. If you're a 
designer or a consulting engineer, additional memory and a hard disk will help 
you eliminate the delays. 

WORD PROCESSING 

No extra hardware requirements here. In fact, a diskette is preferable to a hard 
disk for word processing because it makes it easier for you to organize your files. 
(Recommended: one diskette for every file folder you used to have. So buy your 
diskettes ten at a time. And purchase a diskette holder.) 
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DATA MANAGEMENT 

It can take only a few hundred records to exceed the 128 Kb memory capacity of 
the basic Macintosh (in part because almost two-thirds of the memory is taken 
up by the Macintosh operating system and the data-management software). You 
will need two hardware additions to maintain a larger number of records. Ex­
pand your memory to 512 Kb, and purchase a hard disk, since files this large 
exceed the capacity of a single diskette and otherwise can take five minutes or 
more to load. 

ACCOUNTING AND INVENTORY CONTROL 

A computerized accounting or inventory-control system is really a data-man­
agement system at heart and has the same hardware requirements as a result. 
Before you buy accounting software for your Macintosh, expand your memory 
to 512 Kb and purchase a hard disk. 
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Index 
Page numbers in italic refer to illustrations 

Absolute reference, 34 
Accounting 

hardware for, 162 
software for, 148-149 

Appointment scheduler, 149 
Area chart, 57, 59, 64 
Audit trail, maintaining clear, 39 

Back to Basics, for financial statements, 148 
Balance, computing running, 19-22, 20-21 
Bank deposit, spreadsheet for computing 

interest on, 31-36, 32, 35 
Bar chart, 42, 45, 46, 51, 55-56, 60-62, 65-66 
Boldface, 88, 90 

Calculations 
scientific and engineering, 36 
spreadsheet for quick, 31, 33-36 

Chaining reports, 136-137, 136 
Charts, 41-69, 42-66 

area, 57, 59, 64 
bar,42,45,46,51,55-56,60-62 
column, 42, 46, 55-56, 60-62, 65-66 
combination, 62, 63, 66-67 
contour plot, 58 
creative formatting with, 67-69 
line, 51, 53, 55, 57, 59, 63 
for multiple comparisons, 59-67 
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overlay, 62, 63, 66-67 
pie, 47, 48, 50, 52, 52-54, 56 
for sales analysis, 47-58 
sea tter plot, 5 7 - 58 
using, 44-47 

Checkbook, electronic, spreadsheets for, 15, 
17-24, 16-23 

Clients. See Prospects 
Clipboard, Macintosh, 85-88, 90 
Column, sorting, for electronic checkbook, 

22-24, 22, 23 
Column charts, 42, 46, 55-56, 60-62, 65-66 
Communications software, 150-151 
Comparisons, multiple, chart for, 59-67 
Compuserve, 150 
Contour plot, 58 
Copies of image, 143 
Copying. See Saving work on disk 
Cursor, organizing with, 94-96 

Data, protecting, 29, 39, 78, 83-86, 116 
Data analysis, 41 
Data management. See also Filevision 

computerized, 98-122 
hardware for, 162 

DaVinci Interiors, 152, 154 
Designs. See Sketches 
Dialog box ofMegaMerge, 132, 133 
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Disk, saving to, 29. See also Data, protecting 
Disk drives 

second, for spreadsheet application, 40 
two, as minimum, 160-161 

Documentation, 40 
Documents, merging, 82-87 
Drawings. See Sketches 

Editing 
of form, using Filevision, 107 -109, 107 
with ThinkTank, 96 

Editor, and word-processing software, 76 
Educational applications for Filevision, 

117-119 
Engineering, calculations for, 36 
Error message, 34 
Errors 

correcting, 12 
on spreadsheets, correcting, 39 
typing, correcting, 50 

File managers, 101-122 
Files, saving. See Saving 
Filevision, 101-122 

editing, 107 -109 
educational capabilities of, 117-119 
entering data, 112 
for inventory control, 138, 139, 144 
limitations of, 119-122 
mapping territory, 109-111 
other capabilities of, 115-117 
printing results, 113, 114, 115 
searching for prospects, 113 
using, 101-107 
wild cards, 113 

Form letter. See also Letter 
creating, 130-132 
personalized, 132, 134-135 
merging and printing, 129-131, 132, 133 

Format menu, options of, 17, 18 
Formatting, creative, using Chart, 64, 67-69 
Formula, summation, entering, 13 
Front Desk, 149 

Graphics. See also Map; Sketching 
in other Filevision capabilities, 115-117, 

117-121 
Graphics list manager, 100 
Graphs, 36-38, 37, 41-69. See also Chart 

Hard copy, printing, 13 
Help menu, Multiplan, 15, 16 
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Highlight feature 
in inventory control, 144, 145 
for prospects, 109-112, 113, 115 

Information. See also Data 
immediate access to, 150 

Interest on bank deposit, computing, 31-36, 
32,35 

Interest rate, monthly, 33 
Inventory, 138-146 

building, 139, 140-142, 143, 144 
hardware for control of, 162 
parts department in, 143-146, 145 

Labels, mailing, printing, 132, 134 
Languages, programming, 151, 153-154 
Letter. See also Form letter 

creating, with MacWrite, 72-82, 77-81, 
83-87 

Line chart, 51, 53, 55, 57, 59, 63 
Linking, 111 

MacPaint, 154 
MacProject, 149 
Mac Write 

creating letter with, 72-82, 77-81, 83-87 
rulers of, 85, 86, 91, 92 

Mail merging, 123, 125. See also MegaMerge 
Mailing labels, printing, 132, 134 
Mailings, mass. See Mass mailings 
Manpower assignments, spreadsheets for, 

24-31, 25-30, 32 
Map of prospects, 102-104, 102, 108, 109-111 
Mass mailings, 123-137, 124-131, 133-136 

building list of prospects, 126-128 
chaining reports, 136-137 
creating form letters for, 130-132, 134-135 
MegaFiler and MegaMerge for, 129-130 
printing mailing labels for, 132 
three steps in producing, 125 

MegaFiler, 128, 129-130 
MegaMerge, 123, 124, 125, 129-130, 129-136, 

136-137 
dialog box of, 132, 133 

Memory, extra, for use in spreadsheet, 40 
Merging. See also MegaMerge 

printing and, of form letter, 129-131, 132, 133 
Mistakes. See Errors 
Multiplan, 7, 8, 15, 16 

Outline, creating, with ThinkTank, 91, 94-96 
Overlay, Chart, 62, 63, 66-67 
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Paraprofessional, desk-top computer and, 
76-77 

Parts department in inventory, 143-146, 145 
racks, shelves, boxes, and items, 146 

Pie chart, 47, 48, 50, 52 , 52-54, 56 
Power supply, backup, 116 
Printing 

of form letter, 129-131 , 132, 133 
hard copy, 13 
of mailing labels, 132, 134 
results of search for prospects, 113, 115 

Presentations, 41-43 
Productivity, increasing, 40, 147 -154 

accounting software for , 148-149 
communications software for , 150-151 
developing your own software, 151 , 153-154 
other, 154 
scheduling software for, 149 

Programming languages, 151 , 153-154 
Programs, for office needs, 1-4. See also 

Software 
Proj ect schedulers, 149 
Prospects, 98-122 

building list of, 126-128 
Filevision for files of, 101-122. See also 

Filevision 
highlighted, 109 - 11 2, 113, 115 
searching for , 113 
template for list, 126, 127 -128, 127 

Protecting data, 29, 39, 78, 83-86, 116 

Reference 
absolute, 34 
relative, 33 

Replicating, 31 , 33 
Reports 

chaining, 136-137, 136 

preparing longer, 93 
Rulers, of MacWrite, 85, 86 , 91 , 92 

Sales analysis 
Chart for, 47-58 
spreadsheet for, 6, 8 - 12, 10-14, 36-38, 37 

Saving work on disk, 29, 78, 83-86. See also 
Protecting data 

Scatter plot, 5 7 - 58 
Schedulers, project, 149 
Scheduling software, 149 
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Scientific calculations, 36 
Search, with ThinkTank, 96-97 
Secretary, need for , 73-77 
Sketching and designs, 43-44, 154. See also 

Graphics 
copies of image, 143 
in inventory control, 139, 141-142, 141 , 142 

Software 
accounting, 148-149 
communications, 150 - 151 
developing your own, 151, 153 - 154 
evaluations of, 155-159 
askey,1-2 
scheduling, 149 

Sorting, with ThinkTank, 96-97 
Source , The, 150 
Spreadsheets, 5-40 

application of, knowing, 38-40 
for computing interest on bank deposit, 

31-36, 32, 35 
for electronic checkbook, 15, 16-23 , 17 - 24 
graphing results , 36 - 38, 37 
hardware for , 161 
for manpower assignments, 24 - 31 , 25-30, 32 
productivity increased through use of, 40 
tables, 6, 8-15, 6-14 
using effectively, 38 
who uses, 6-7 
word processor for enhancing, 88, 90-92 

Statistical functions, Multiplan for , 15, 16 
SUM, for calculations, 15 
Summation formula, 13 
Symbols, 142, 143, 144 

Tables, building, 6, 6-14, 8-15 
Taurus One/ 05, 153, 154 
Telos Software, 120 
Templates, 126, 127-128, 127, 152, 154 
Territory. See Map 
ThinkTank 

creating with, 91, 94-96 
editing with, 96 
other applications of, 96-97 

Trend line, 60-61 
Typist, desk-top computer and, 75 - 78 

Underline, 88 , 90 

Word-processing software, 71-97 
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